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2.1

Introduction

This is a user guide for the Qwizdom Connect. This guide provides information and tips on
using Qwizdom Connect.

If you need assistance, please contact Technical Support.

Website www.qwizdom.com
Tech Support (253) 770-1285

Email support@gwizdom.com
Support Hours 6 a.m. to 4:30 p.m. PST
Address Qwizdom, Inc.

12617 Meridian East
Puyallup, WA 98373

Some map images are derived from maps © 2006. Map Resources, Lambertville, NJ 08530 www.mapresources.com

Getting Started

Contents of Remote Set
Q2RF, Q4RF, or Q5RF Remotes*
1 RF Host
1 Q5RF Instructor Remote or 1 Q7RF Instructor Tablet*
1 USB Cable
1 Charger (Q5RF Instructor Remote)*
1 Multi-charger (Q5RF Remotes)*
1 Screwdriver
AA Batteries (Q4RF) or AAA Batteries (Q2RF)*
1 Remote Carrying Case
1 Quick Reference Guide

1 Software; Qwizdom Connect
*Remote types and accessories based on actual order. This device complies with part 15 of the FCC Rules. Operation is subject to
the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.

Notice

Notices of Compliance for Qwizdom's RF Response Devices

Qwizdom Connect 2008
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Note: This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, users and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occurin a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measures:

e Reorient or relocate the receiving antenna.

¢ Increase the separation between the equipment and receiver.

e Connect the equipment into an outlet on circuit different from that to which the
receiver is connected.

e Consult the dealer or an experienced radio/TV technician for help.

Caution: Changes or modifications to Qwizdom's RF hardware that are not expressly
approved by Qwizdom could void the user's authority to operate the equipment.

(€09310

This product is designed for the 2,4 Ghz WLAN network throughout the EC region and Switzerland with restrictions in France.

2.2 Installing Qwizdom Connect

System Requirements
Windows XP Service Pack 2 or later

Microsoft PowerPoint® 2003 or later (registered version)

Microsoft Excel® 2003 or later (registered version)
Microsoft .NET Framework 3.5 (included in installer)

Intel Pentium 233-MHZ or faster processor (Pentium Il recommended)
1G of RAM

5 GB of disk space

CD-ROM drive

Open USB Port

Installing Qwizdom Connect from CD
1. Insert the Qwizdom Connect disc into the CD-ROM drive, follow the Installation
Wizard.
2. Click on Next. The Select Installation Folder window appears.
3. You have the option to select the location of where you would like Qwizdom
Connect to be saved or use the default location.
4, Click on Next to begin the installation. This will take a few moments.

Qwizdom Connect 2008



5 Qwizdom Connect User Guide

5. Once the installation is complete, click on Close and restart your computer.

Registration Wizard
1. The first time you open Qwizdom Connect the Registration Wizard should appear. If
it does not automatically appear go to the File menu and select Preferences. This
will bring up the Preferences window. In the bottom right hand corner of the
window, select Start Registration Wizard. The Registration Wizard window appears.
2. Press the Next button to continue.
Enter the customer type and press the Next button.
4, Select your state from the drop-down menu and select all subjects that you teach.
In this step, you are setting the User Properties for your content filter search.
Click on Next.
6. Enteryour Alias. An Alias is your screen name that will appear should you choose
to share content using our online sharing features.
Click Next to continue.
Connect will download state standards.
9. (lick Finish to complete registration.

w

b

®© N

2.3 Hardware Setup

1. Plug the USB cable into the RF Host and then plug the other end of the USB cable
into an open USB port.

2. Place two AA batteries (provided in the remote set) and insert the screw (optional)
into the back of the Q4RF remote to secure the battery compartment; or place two
AAA batteries (provided in the remote set) and insert the screw (optional) into the
back of the Q2RF remote to secure the battery compartment. Plug the Q5RF
participant and Q5RF instructor remotes into the multi-charger and/or single
charger for 24 hours before first use.

Installing USB Drivers on Vista (RF Host)

You will need to do this procedure twice (because there are two drivers).
1. Insert the Qwizdom Connect disc into the computer and make sure the host is

plugged in properly.

From the Start menu, go to the Control Panel.

Click on Hardware and Sound.

Click on Device Manager.

Select View Devices by Type under the View menu.

Qwizdom RF Host should be located under Universal Serial Bus Controllers, Ports and

Unknown or Other Devices.

7. Right-click on Qwizdom RF Host and select Update Driver. The installation wizard
will appear.

8. Select "Browse Computer for Software Driver" and click on Next.

oukwnN
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10.
11.
12.
13.
14.

Click on the Browse button. The Open window appears.

Click on My Computer.

Click on the drive the Qwizdom Connect CD is in.

Select the USB_Drivers folder.

Click on OK and then on Next.

When it's done installing, click on Close. Repeat the above steps once more and
then restart your computer.

Installing USB Drivers on Windows XP (RF Host)

You will need to do this procedure twice (because there are two drivers).

1.

N

ou kW

10.
11.
12.
13.
14.
15.

16.

Insert the Qwizdom Connect disc into the computer and make sure the host is
plugged in properly.

From the Start menu, go to the Control Panel or go to Settings and then Control
Panel.

Double-click on the System icon and click on the Hardware tab.

Click on the Device Manager button.

Select View Devices by Type under the View menu.

Qwizdom RF Host should be located under Universal Serial Bus Controllers, Ports and
Unknown or Other Devices.

Right-click on the Qwizdom RF Host and select Update Driver. The installation wizard
will appear.

Select "Install from a list or specific location" and click on Next.

Select "Include this location in search" boxes.

Click on the Browse button. The Open window appears.

Click on My Computer.

Click on the drive the Qwizdom Connect CD is in.

Select the USB_Dirivers folder.

Click on OK and then on Next.

A prompt will appear that says the drivers have not passed the Microsoft Windows
Update testing, click on Continue Anyway and then Finish.

Repeat the above steps once more and then restart your computer.

3 Live Editor

Create and present multimedia activities, lessons, and tests in Live Editor using premade
styles , tools, and templates or creating your own.

1.

Go to the Programs menu and select Live Editor; or right-click on the Qwizdom
Connect tray icon and select Live Editor.

Qwizdom Connect 2008
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Slide navigator

Q. - .
“  (Create new question

I

| Indicates Information slide

Qindicates question slide
A indicates answer slide
" Copies current slide as into slide set

Launches Presentation Setup Window

Deletes a selected object on the slide

ﬁxilﬁl

" Undo/redo

f " Pen tool
/ " Line tool
"N, .

=3 Shapes tool

A " Text tool
Z MathML

Insert image

v

- |nsert multimedia

* Color palette

"

Change Viewing Mode

(switch view to Integrated and
Full Screen Mode)

..............

L Expand or Collapse Live

Editor Toolbar.
(Only appears in Full Screen
Mode)

......Selects objects on slide

Pen Tool

Click on the f " Pen tool drop-down arrow.
Select Customize . The Customize Pens window appears.

Click on the ) Add button and choose thickness, color, and transparency.

1.
2.
3.
@ Click on the E] Delete button to delete a pen style.
4. Click on OK to save the pen style(s).

Line Tool

1. Click on the /- Line tool drop-down arrow.
2. Select Customize . The Customize Line window appears.
3.

Click on the lZJ Add button and choose thickness, color, and transparency.

@ Click on the B Delete button to delete a line style.
4. Click on OKto save the line style(s).

Shapes Tool

Qwizdom Connect 2008
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1. Clickonthe * Shapes tool drop-down arrow.
2. Select Customize. The Customize Shapes window.
3.

Click on the lZJ Add button and choose thickness, color, and transparency.

E Click on the B Delete button to delete a shape.
4. Click on OK to save the custom shapes.

Text Tool

1. Click on the A " Text tool arrow.
2. Select Customize . The Customize Text window appears.
3.

Click on the ) Add button and choose font type, size, and attributes.

E Click on the E] Delete button to delete the custom font.
4. Click on OKto save the custom font.

Font Toolbar

To view Font toolbar either click on an active text box or the A Text tool.

Font: Arial " Font type selector = Center justify
= " Font size selector = Right justify
B Bold font * Subscript
iltalicizes font _zSuperscript
U Underlines font =7 Bullets
Left justify T¥PE ™ Text box type

Slides Tab
Displays thumbnails of all slides in the activity.

Qwizdom Connect 2008
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Slides
"

—

Which is not a fruit?

a) Rhubarb
b) Tomato

¢) Cucumber
d) Pumpkin
e) Pineapple

ermplates [f‘a Media

Media Tab

Allows you to search and use images in the Qwizdom database.

| Search i

Media | ] Slides

| Browse

Fewaords:

Templates Tab

Displays slide templates.

Filter far zelected question type

Cateqary ;-.-.’-'-.II lvv D

[ Ewxport... H Irnpart. .. ]

¥ Media [ [ Slides

Styles Tab

Tipe yous guassbon

il Templates
?
i

Displays slide styles.

Qwizdom Connect 2008
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3.1

Edit Styles...
Category | All W

Heallig

cegtion

ANEWETE

Haadlng

ilesml
L

L Styles | [TI] Templates [fn Media [ FJ Slides

Creating Slides

There are two ways to open Live Editor.
¢ Go to the Programs menu and select Live Editor.
e Click on the Content tab and select an activity from the tree. Then double-click on

any slide in the activity to launch Live Editor.

Information
Non-question slide (non-remote).

1. Click on the 9 - New Question button. A blank slide will appear on the right and
the thumbnail preview of the slide will appear in the Slides tab on the left.

2. Click on the Type drop-down list and select None as the slide type.

3. Enter text onto the slide; adding multimedia such as images, movies, sound and

using templates and styles are optional.
4. When the slide is complete, either go to File menu and select Exit; or click on the

Q. - , .
“  New Question button to create a new slide set.

Multiple Choice
Multiple choice question slide (up to six choices). Use with Q2RF, Q4RF, and Q5RF.

1. Click on the % - New Question button. A blank slide will appear on the right and
the thumbnail preview of the slide will appear in the Slides tab on the left.

2. Click on the Type drop-down list and select Multiple Choice as the slide type.

Setting the time limit and number of points are optional.

4. Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

5. Select the correct answer in the Answer field.

w

Qwizdom Connect 2008
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6. Creating an answer slide is optional. To create an answer slide, click onthe = € ~
Add Slide button (optional). A new slide will appear within the slide set.

7. Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

8. When the slide is complete, either go to File menu and select Exit; or click on the

ax - . .
“  New Question button to create a new slide set.
Yes/No

Yes/No question slide. Use with Q2RF, Q4RF, and Q5RF.

1.

Click on the Tl - New Question button. A blank slide will appear on the right and
the thumbnail preview of the slide will appear in the Slides tab on the left.

2. Click on the Type drop-down list and select Yes/No as the slide type.

3. Setting the time limit and number of points are optional.

4. Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

5. Select the correct answer in the Answer field.

6. Creating an answer slide is optional. To create an answer slide, click on the - = T
Add Slide button (optional). A new slide will appear within the slide set.

7. Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

8. When the slide is complete, either go to File menu and select Exit; or click on the

Q. - . .
“  New Question button to create a new slide set.
True/False

True/False question slide. Use with Q2RF, Q4RF, and Q5RF.

1.

w

Click on the Qal - New Question button. A blank slide will appear on the right and
the thumbnail preview of the slide will appear in the Slides tab on the left.

Click on the Type drop-down list and select True/False as the slide type.

Setting the time limit and number of points are optional.

Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

Select the correct answer in the Answer field.

Creating an answer slide is optional. To create an answer slide, clickonthe =~ @
Add Slide button (optional). A new slide will appear within the slide set.

Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

When the slide is complete, either go to File menu and select Exit; or click on the

Q- ) .
“  New Question button to create a new slide set.

Qwizdom Connect 2008
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Numeric
Numeric question slide. Single digit numeric answer allowed for Q2RF; nine digit numeric
answer allowed for Q4RF; and eight digit numeric answer allowed for Q5RF.

1.

Click on the Tl - New Question button. A blank slide will appear on the right and
the thumbnail preview of the slide will appear in the Slides tab on the left.

2. Click on the Type drop-down list and select Numeric as the slide type.

3. Setting the time limit and number of points are optional.

4. Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

5. Enter the correct answer in the Answer field and press the Enter key on the
keyboard to save it.

6. Creating an answer slide is optional. To create an answer slide, click on the - = T
Add Slide button (optional). A new slide will appear within the slide set.

7. Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

8. When the slide is complete, either go to File menu and select Exit; or click on the

Q. - . .
“  New Question button to create a new slide set.
Sequence

Place item choices in the specified order. Use with Q4RF and/or Q5RF.

1.

w

Click on the New 9 - Question button. A blank slide will appear on the right and
the thumbnail preview of the slide will appear in the Slides tab on the left.

Click on the Type drop-down list and select Sequence as the slide type.

Setting the time limit and number of points are optional.

Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

Enter the correct answer in the Answer field and press the Enter key on the
keyboard to save it.

Creating an answer slide is optional. To create an answer slide, clickonthe =~ @~
Add Slide button (optional). A new slide will appear within the slide set.

Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

When the slide is complete, either go to File menu and select Exit; or click on the

Q- ) .
“  New Question button to create a new slide set.

Multiple Mark
This question type enables two or more correct answers (up to six choices). Use with Q4RF
and/or Q5RF.

1.

Click on the Tl - New Question button. A blank slide will appear on the right and

Qwizdom Connect 2008
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w

the thumbnail preview of the slide will appear in the Slides tab on the left.

Click on the Type drop-down list and select Multiple Mark as the slide type.
Setting the time limit and number of points are optional.

Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

Enter the correct answer(s) in the Answer field and press the Enter key on the
keyboard to save it.

Creating an answer slide is optional. To create an answer slide, clickonthe =~ @~
Add Slide button (optional). A new slide will appear within the slide set.

Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

When the slide is complete, either go to File menu and select Exit; or click on the

Q- ) .
“  New Question button to create a new slide set.

Rating Scale
Rating scale question slide (i.e. rating/opinions/polling using scales from 1-5, 1-10, etc.).
Use with Q4RF and/or Q5RF.

1.

w

Click on the Tl - New Question button. A blank slide will appear on the right and
the thumbnail preview of the slide will appear in the Slides tab on the left.

Click on the Type drop-down list and select Rating Scale as the slide type.

Setting the time limit and number of points are optional.

Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

Select the correct answer in the Answer field.

Creating an answer slide is optional. To create an answer slide, click on the -~ & T
Add Slide button (optional). A new slide will appear within the slide set.

Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

When the slide is complete, either go to File menu and select Exit; or click on the

Q. - . .
“  New Question button to create a new slide set.

Text Input (only applicable to Q5 RF remotes)
Answer can be up to 30 characters long.

1.
2.
3.
4.

5.

Click on the 9 - New Question button. A blank slide will appear on the right and
the thumbnail preview of the slide will appear in the Slides tab on the left.

Click on the Type drop-down list and select Text Input as the slide type.

Setting the time limit and number of points are optional.

Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

Enter the correct answer in the Answer field and press the Enter key on the

Qwizdom Connect 2008
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keyboard to save it.

6. Creating an answer slide is optional. To create an answer slide, click on the = @ ~
Add Slide button (optional). A new slide will appear within the slide set.

7. Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

8. When the slide is complete, either go to File menu and select Exit; or click on the

9 - New Question button to create a new slide set.
Survey
Survey question slides do not have a correct answer. Use with Q2RF, Q4RF, and Q5RF.
: Qq - , o :

1. Clickonthe "% New Question button. A blank slide will appear on the right and
the thumbnail preview of the slide will appear in the Slides tab on the left.

2. Click on the Type drop-down list and select None as the slide type.

3. Setting the time limit and number of points are optional.

4. Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

5. Select "None" in the Answer field.

6. Creating an answer slide is optional. To create an answer slide, click on the = @ ~
Add Slide button (optional). A new slide will appear within the slide set.

7. Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.

8. When the slide is complete, either go to File menu and select Exit; or click on the

9 - New Question button to create a new slide set.
3.2 MathML

1. Clickonthe z Equation button. MathML opens.

2. Enter an equation in the MathML window.

3. Click on the Close button (red X) when finished.

4. The equation will appear on the slide as an object.

5. You can resize the equation by stretching the handles (click and drag).

3.3 Styles and Templates

Live Editor makes creating, editing, applying styles and templates easy.

Applying Styles

1.
2.

Create a slide with text.
Click on each text box and set the text box type (Heading, Body 1, Body 2, Answer
Choices).

Qwizdom Connect 2008
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3. Click on the Styles tab. Select a Category from the drop-down menu.
4. There are two ways to apply a style.
e Click and drag the style to the slide (on the right) to apply.
e Right-click on the style and select Apply to Slide, Apply to Question, or Apply to
Activity.
5. You are able to change the font style, size, and color after applying the style.

Creating Styles
1. Click on the Styles tab.

2. Click on Edit Styles. This will bring up the Styles Management window.

3. Select the New button. The Input window appears, enter the name of your style,
and click OK.

@ Create a unique name for each style to make it easier and accurate for
importing, exporting, and applying styles.
4. Click on each tab to customize text, background, shapes, and categories of your
newly created style.

5. Create as many styles as you like. Click Done when finished.

Style Managemont
Gty It snshon
Heme | [ielul =
.hlzw | Exp;ﬂ || tmpnt |

| Dupicate. |

SeHing:
Test | Bachgeeurd | Shapes | Caleooses

o=
Text tab:
e Select Font Family, color, accent color (highlight), and style (Bold, Italic, and/or
Underline)
Background tab:

e Apply a Background Image- check the Back Image box and browse for the image.
Click Open, and thumbnail preview will appear in the Sample window.

e Apply a Background Color- check the Back Color box, and double-click inside the
Color box ( located to the right of the Back Color box.

Qwizdom Connect 2008
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e Apply aFilter Color- is a tint feature you can apply a tint to your background image.
Double-click in the Color box and use the up and down arrows to apply the Filter
Opacity. Notice the thumbnail preview changes as you change Filter Opacity.

e Content Filter Color- changes the color behind your content. Double-click in the
Color box and use the up and down arrows to apply the Content Filter Opacity. Notice
the thumbnail preview changes as you change Content Filter Opacity.

ﬁ The Content Filter Opacity will overwrite your Filter Color unless you scale the
size of content (see below for Content Scaling).
e Content Scaling- allows you to shrink and justify your content area. To decrease
overall size use the up and down arrows to increase or reduce percentage. To justify
scaling, select an icon that best fits your content needs.

Shape tab:

e Shape thickness-determines the size of stroke applied to drawn shapes. To select
thickness, check the Shape Thickness box, and type in the thickness of the line.

e Fill Color- applies selected color to all shapes drawn on in activity. To select color,
check the Fill Color box (if Fill Color box is unselected, the default color will be
applied to any drawn shapes), and double-click the Color box.

e Border Color-applies selected color to outline/stroke of any drawn shape. To select
color, check the Border Color box (if fill Border Color box is unselected, the default
color will be applied to any drawn shapes).

Categories tab:

e Categories-organize your styles in categories. Scroll through the list and check all
categories that apply( All, Abstracts, Biology, Cultures, Education, History, etc.). This will
add your style to the appropriate category in the main Style tab.

o Edit Categories- create, rename, and delete categories.

Edit Styles
1. Click on the Styles tab.

2. Double-click on the style you want to edit. The Style Management window appears.
3. Edit the style settings. See Creating Styles above for options.
4, Click on Done when finished editing.
5.  Reapply the style to view the updated style.
Delete Styles

1. Click on the Styles tab.

2. Double-click on the style that you want to delete. The Style Management window
appears.

3. The style name appears in the Name field.
4. Click on Delete. A prompt will appear asking if you want to delete.
5. Clickon OK.
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6. Click on Done to exit the Style Management Window.

Import Styles
1. Click on the Styles tab.
2. Click on Edit Styles. The Style Management window appears.
3. (lick on Import. The Open window appears.
4. Select the .QSP (styles) file you want to import.
5. Click on Open. The styles will import into Live Editor.
If there is a duplicate style already in Live Editor, it will ask you to Overwrite or Ignore.

Export Styles
Exporting styles exports all styles as a .QSP file.
1. Click on the Styles tab.

2. Click on Edit Styles. The Style Management window appears.

3. Click on the Export button. The Save As window appears.

4. Select the location where you want the styles to save in.

5. Enter the name you want the styles to be saved as.

6. Click on Save. The styles saved in the selected location.
Applying Templates

1. Click on the Templates tab.
2. There are two ways to apply a template.
¢ Click and drag the template onto the slide.
¢ Right-click on the template and select Load Template.
Templates must be applied before creating the slide.

Creating Templates
1. Create a slide with text and/or images and multimedia.
2. Goto the File menu and select Save As Template.
3. Enter a name for the template.
4. Select the slide type in the Question Types tab to set template question type filter.

m Use Question Type Filter to sort and display the templates for a specified
question type (selected in the Type field) by checking the "Filter for selected
question type."

5. Select the Categories tab.
6. Select a category and click on Done.

By default there are no pre-determined template categories. You must create categories,

see Creating Categories for Templates below for more information.

Creating Categories for Templates
1. Click on the Templates tab.
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3.4

2. Clickon D Browse button. The Categories Editor window appears.
3. Enter a category name.
4. Click OKwhen finished.

Multimedia

Adding Images

There are two ways to add an image to a slide.

Inserting a Image

Click on the Add Image button in the toolbar. The Open window appears.
Select the image and click on Open.

The image will appear on the slide.

Grab and drag the handles of the image to resize to desired size.

LN =

Using Media Search

Click on the Media tab.

2. Enter the keyword(s) in the Keywords field to search for an image.

3. Images matching the keyword(s) you entered will appear in the Media tab.
4. Select an image by dragging and dropping it onto the slide (on the right).

—_

Adding Movies

1. Click on the " Add Video button in the toolbar. The Open window appears.

2. Select the movie and click on Open.

3. The movie will appear on the slide.

4. Double-click the movie to play or stop it; or set the media properties.
Adding Sound

1. Click onthe " Add Video button in the toolbar. The Open window appears.

2. Select the sound file and click on Open.

3. The sound file will appear on the slide.

4. Double-click the sound file to play or stop it; or set the media properties.
Media Control

Media Control is used for presentation when the instructor remote will not be used.
1. Go to the Window menu and select Media List. The Media Control window appears.
The Media Control will appear during presentation.
Al % CI2 [4] >
il
[

e Play-blue triangle
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Pause-double green bars
Stop-red circle

Setting Transparency for Flash Movies

1.

vk wnN

Insert a flash movie onto the slide.

Right-click on the flash movie and select Properties.

Check the "Play Transparently" box.

Click on OK.

Click on the movie. The flash movie is transparent only when playing.

Media Properties

Media Properties

M anme:; EECOECAES1ADCT TAF5E435ABDEIED2T, sud
Locationr  C:ADocuments and Settingshall Users'dpplicati

[]visible in presentation

] Show Controller

[] Repeat

[] Close when finished

[] Play full sereen

[] PlayTransparently
Autoplay Options

[ ] Play autormatically
Delay 4 seconds before playing

| ok | [ Cance |

Visible in presentation-displays the movie and/or sound file with name on slide.
Play when clicked-to play the movie or sound file when clicked with mouse.

Show Controller-displays a box of the movie and/or sound file names with play and
stop buttons.

Repeat-repeat movie or sound file continuously when the slide is displayed.

Close when finished-to stop movie or sound file when finished.

Play full screen-for movies, plays movie in full size; for sound, displays sound in
colors (best used with only the sound file on the slide).

Play Transparently-applies to Flash movies; background becomes transparent
when movie is played.

Play automatically-to play the movie or sound file upon slide display.

Delay ---- seconds before playing-enter number of seconds for the movie or sound
file to play.
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Setting Media Properties

Right-click on the movie or sound file.
Select Properties.

Select the options for presentation.
Click on OK to apply.

—_

H W

4 Content Manager

Content Manager is where all created and imported activities are stored.

Click on the Content Manager tab; or right-click on the Qwizdom Connect tray icon and
select Content Manager.

Create a New Folder

1. Click on the ““*%. New Folder button.
2. Enter a name for the folder and click on OK.
3. Thefolder appears in the Content Tree on the left.

Create a New Activity

1. Click on the 2.7 New Activity button.
2. Enter a name for the activity and click on OK.
3. The activity appears in the Content Tree on the left.

Create a New Answer Key

Click on the black arrow to the right of the E. W New Activity button.
Select "Create and Add Answer Key file" and enter a name.

Click on OK and the answer key will appear in the Content Tree on the left.
Double-click on the answer key file to launch the Answer Key window. See
AnsweriKXey for more information.

PN =

4.1 Importing and Exporting

Importing Activities (.QAP and .QZA)
1. Go to the File menu and select Import Activity or Archive. The Open window
appears.
2. Select the File of Type: .QAP or .QZA to import.
3. Select the activity and click on Open. The activity will import into the Content Tree.
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m You can also drag and drop activities (.QAP, .QZA, .QAK) into the Content Tree.

Importing External Documents
1. Go to the File menu and select Import External Document. The Open window
appears.
2. Select the file you would like to import and click on Open. The external document
will import into the Content Tree.

Exporting Activities
1. Go to the File menu and select Export. The Save As window appears.
2. Choose the location to export your file and select OK.

4.2  Printing

1. Select an activity and go to the File menu.
2. Select Print. The activity will print.

4.3 Standards

Installing Standards
1. Go to the File menu and select Preferences.
2. Click on the Standards tab.
3. Select your state standards in the Select State drop-down list.
4. Click on Download State Standards to download your state standards into Qwizdom

Connect.
Applying Standards
1. Clickonthe Standards button. The Standards window appears.

2. Select the standard at the level you want to apply to the slide(s).
3. Click on Add and then Done. The standards will appear in the Standards tab at the
bottom of the Content Manager window.

@ If the Standards Properties tab isn't displayed, go to the View menu and select
Properties.

5 Presentation
Activities can be presented with or without Qwizdom remotes.

Presenting an Activity (with Remotes)
1. Select an activity to present.
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2. Click onthe A Present button. The Presentation Setup window appears.
3. Click on the Participant List drop-down arrow and select what type of participant
list you would like to use.
4. Click on the Saved Results drop-down arrow and select how you would like to save
the results.
5. Select the options you would like available during presentation in the General,
Login, and Display tabs in the lower part of the Presentation Setup window.
6. Click on OKto begin the presentation.
7. Have the participants turn on their remotes.
8. Either the answer choices or a blank screen will appear on the remote, depending
on the question type.
9. Here are a few things you may execute during presentation:
e Display the response chart by pressing the / key
e Display the private graph by pressing the zero key
e Randomly call upon a participant by pressing the Pick key
10. Go through the presentation until all the question slides are answered.

@ See UsinglRemotesliniPresentation for description and troubleshooting of all the
remote LCD screen messages.
11. When you are unable to advance to the next slide, this means the presentation is

complete. Click on the ®Utilities button and select Exit.

Presenting an Activity (without Remotes)
Select an activity to present.

2. Clickonthe A Present button. The Presentation Setup window appears.

3. Click on the Participant List drop-down arrow and select what type of participant
list you would like to use.

4. Click on the Saved Results drop-down arrow and select None (Do not save).

Select the options you would like available during presentation in the General,

Login, and Display tabs in the lower part of the Presentation Setup window. See

PresentationlSetup for complete descriptions of presentation features.

—_

b

@ Under the Display tab, you must check the Show Function Toolbar to view
presentation features. See Presentation Features of more information.

Check the "Do not use Qwizdom Remotes" box.

Click on OK to begin the presentation.

Go through the presentation until all the question slides are answered.

When you are unable to advance to the next slide, this means the presentation is

O o N O

complete. Click on the ®Utilities button and select Exit.

Presenting Multiple Answer Keys
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Before presenting an activity using Qwizdom remotes, please see PresentationiSetuplto
learn about the presentation features.
1. In the tree of the Content Manager, select the folder that contains the answer keys.

2. Click on the A Present button.

3. The Presentation Setup window appears.

4. Click on the Participant List drop-down field and select what type of participant list
you would like to use.

5. Click on the Saved Results drop-down field and select how you would like to save
the results.

6. Select the options you would like available during presentation in the General,
Login, Display, and Chart tabs in the lower part of the Presentation Setup window.

7. Click on OK to begin the presentation.

8. The Privacy Screen appears.

9. Activity ID will appear on the remote LCD screen.

@ An activity ID is the answer key test number. Double-click on the answer key to
launch Answer Key to view the test number. Write down the test number for
each answer key for participants to enter.

10. Enter the test number (activity ID) of the answer key into the remote and press the
Send key.
11. The answer key will load into the remote.

@ See UsinglRemotesliniPresentation for description and troubleshooting of all the
remote LCD screen messages.

12. Click on the Red X to show a grid of the participants progress (optional).

13. When all answer keys have been completed, click on the M] End Session
button.

14. You will be taken back to the Answer Key Maker window.

15. The saved results will save in the location you selected.

Using Multiple Hosts

Up to 3 hosts (with 1000 remotes on each) can be used for presentation for Q2RF, Q4RF,
and Q5RF.

If you have selected to use fixed set, be sure you have assigned fixed numbers for the
remotes using all RF hosts.

1. Clickonthe A Present button. The Presentation Setup window will appear.

2. Click on the Login tab.

3. Select the hosts you will be using by placing a check mark in each one of the
boxes.

4. You can create your own Session ID in the User Session column or use the default
Session ID.
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E If you use the default Session ID in the Host Session column, the User Session
column must be blank.

Click on OK to begin the presentation.

When the presentation appears, turn on the remotes.

7. If you assigned fixed numbers, the remotes will automatically log into the correct
host, using the Session IDs used at that time.

8. Enter the appropriate Session IDs into the remotes (including instructor) if
prompted to do so and press the Send (double arrows) key. Press the C (clear) key
to delete if you accidentally mistype a number or see RemotelSetup for more
information.

9. Either the answer choices or a blank screen will appear on the remote, depending
on the question type.

o w

E See UsinglRemotesliniPresentation for description and troubleshooting of all the
remote LCD screen messages.

5.1 Presentation Setup

There are many options you can apply to your presentation. Not all options will be
applicable.

General | Login | Display | Chart
General Setlings

[[] Send Right/wrong Feedback to Remotes afler answering.

[ Abow participaris to change answer

[] Ovenide Poirt Value with Global Point value of 1 poirdz.
Mo Timer w secands.
General tab:

e Send Right/Wrong Feedback to Remotes after answering-remotes will receive a
check mark if answer is correct and an X if answer is incorrect. Remotes will receive
both a check mark and X if feedback is turned off to indicate that the response has
been received.
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o Allow participants to change answer-checking this option allows participants to
change their answer for the question slide they are on.

e Override Points Value with Global Point value of "----" points-enter the new amount
of points that will be applied to the slide temporarily for that presentation.

e Timer-you can select no timer, use the time set within the slides, and global timer by
entering the number of seconds for all slides in the presentation.

Gensral| Loan | Dizplay | Chart

Login Setlings Hardware Settngs
[] Require Login by ID Host Host Session LUser Session
[+] Dwszda, 102962 102962
Show Login Scieen

[[] Add and Alow Unregistered participanis

Dremy Login Afber minuhes
Host Mode: Fred to Host

Login tab:

e Require Login by ID-checking this option will have remotes prompt participants to
enter their Participant ID.

e Show Login Screen-displays the login screen so the instructor can view the
participants that are logging in.

e Add & Allow Unregistered participants-participants will be added to the participant
by logging in with their Participant ID. This option must be checked when using an
Anonymous list. For the Anonymous list, participants will only log in with the Session
ID.

e Deny Login After "----" minutes-logins after the set amount of time will not be
accepted.

Gensral | Login | Display | Chart
Display Sellings
[[] Shew Function toolbar [net resded i using Preserter Remobe]
[] Dusplay Response Indicator
[] Showe StamiStop rezponding 1o questions indicator

Display tab:

e Show function toolbar (not needed if using Presenter Remote)-checking this option
will display toolbar with Response Chart, Pick, and Re-pose buttons.

e Display Response Indicator-this displays the percentage of the class that has
answered; double-click the percentage to convert to a fraction.

e Show 'Start/Stop'responding to questions indicator-clicking on Stop will pause the
presentation and responses will not be accepted. Clicking on Start reposes the
question.
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Gensral| Login | Dizplay | Chait
Chiart Sehlings
] Austomatically Skow Corect Answer on Chart

[[] Backgiound Filename: [:]

Resporse Giaph wall be dhown az

Sedect Graph Lapout |

Chart tab:
e Automatically Show Correct Answer on Chart-checking this option will display
toolbar with Response Chart, Pick, and Re-pose buttons.
e Background Filename-selecting this option will allow you to select an image to
display as the response chart background.
e Select Graph Layout-select how the response chart will be displayed during
presentation.

Advanced Settings
To change advanced settings

1. Clickon A Present. The Presentation Setup window appears.
2. Go File and select Advanced Settings. The Advanced Settings window will appear.

(% Advanced Settings M=%

Advanced Seitings

[] Abow Instnucto bo go back fo a previous shde
[[] Resst ComPot When Stasting Fresantation
[] Ak ice confimnation of Llser 100 when ot on kst

Advanced Hadwae Sellings
[[] Dion’t requite Send on snghe key answers
[[] Dizable Thangs LizedD' menu dusing Logn
] Disable Thangs SessionlD menu duiing Login
[] Disable Thange UsedD' menu duing sclive Session
[[] Dizable Thange SessionlD” meny during active Sezson
[[] Do not show what key was pressed on 02's
[] Tusn ofi remates on prezentation end

ot ) (ema ] |

Advanced Settings

o Allow Instructor to go back to a previous slide-checking this option allows the
instructor remote to move back to a previous slide.

¢ Reset Com-Port When Starting Presentation-this option is checked by default to
ensure the host activates when presentation begins.

o Ask for confirmation of User ID when not on list-the remote will prompt the
participant for the user ID again, if the participant is not in the participant list that is
loaded.
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Advanced Hardware Settings
e Don'trequire "Send" on single key answers-the remote will automatically send the
answer once it has been entered.
e Disable "Change UserID" menu during Login-hides the "User ID" option from the
menu.
e Disable "Change SessionID" menu during Login-hides the "Session ID" option from
the menu.
e Disable "Change UserID" menu during active Session-hides the "User ID" option
from the menu during presentation.
e Disable "Change SessionID" menu during active Session-hides the "Session ID"
option from the menu during presentation.
e Do not show what key was pressed on Q2's-does not show the key that is pressed
on the display.
Turn off remotes on presentation end-automatically turns off the Q2RF and Q4RF
remotes when a presentation ends.

5.1.1 Presentation Settings

Presentation settings can be saved and loaded (onto the same computer or another
computer) into the Presentation Setup window of Actionpoint, Answer Key, and Question Bar
applications.

Saving Presentation Settings
1. In the Presentation Setup window, select the options you would like during
presentation.
2. Goto the File menu and select Save Settings. The Save As window appears.
3. Enter the name for the selected settings.
4. Click on Save. The settings will save as a .CFG file in the location you selected.

Loading Presentation Settings
1. In the Presentation Setup window, go to the File menu.
2. Select Load Presentation Settings. The Open window appears.
3. Select the saved settings file (.CFG) and click on Open.
4. The current settings in the Presentation Setup window will change to the settings
you selected to load.

5.1.2 Saving Results
All results are saved as a .QRX file but can be converted into a .CSV (Comma Separated

Values) file.

Manual Save

1. Clickonthe A Present button. The Presentation Setup window will appear.
2. Select Browse for Save Location.
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5.1.3

3. Click on the LI Browse button. The Save As window appears.
4. Select alocation to save the results in.
5. Enter the name you want the results to be saved as.
6. Click on Save. The file name and location will appear in the Save Results field.
7. The results will save in the selected location.
Auto-save
1. Click on the A Present button. The Presentation Setup window will appear.
2. Select Auto Save as ‘Filename + List + Date.'
3. The Browse for Folder window appears.
4. Select the location and click on OK.
5. The file name will contain the location, name of the participant list, date, and time
under the Save Results field.
6. The results will save when the presentation is complete.

Auto-Save to Results Manager
You must be logged into Qwizdom Online to access this feature.

1.
2.
3.

Click on the A Present button. The Presentation Setup window will appear.
Select Auto Save to Results Manager.

The results will save in the Results/Reports window when the presentation is
complete.

Remote Login

@ If you are presenting with remotes for the first time please see RemotelSetup.

Logging in with IDs allows participants to use any remote. If you use Participant IDs from a
participant list, the ID will link the remote to the participant's information in the list.

To have participants log in, they must have a Participant ID. Participant IDs are setup when
creating participant lists. (Go to Participantilists for more information). Each participant
should have a unique ID assigned to their name.

HwnN

¢ Participant IDs can only be numeric.

The maximum number of digits allowed for IDs using the Q2RF remotes is 8.
The maximum number of digits allowed for IDs using the Q4RF remotes is 9.
The maximum number of digits allowed for IDs using the Q5RF remotes is 8.
IDs cannot be used for more than one participant (IDs cannot be duplicated).
Select an activity or create one to present.

Click on the A Present button. The Presentation Setup window will appear.
Select a participant list from the "Participant List" drop-down menu.
Click on the Login tab.
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5. Check the "Require Login by ID" option.

6. Checking the "Show Login Screen" is optional.

7. Select all other preferred options and click on OK to present. The presentation will

begin.

8. The remotes will display "User ID."

9. Participants will enter their ID and press the Send (double arrows) key.

10. Once everyone has logged in, begin the presentation.
You can start the presentation as participants log in. Participants who are late, can log in
later if you have not set a timer to deny log-in.

Login Timer
You can deny login after a certain amount of time by setting the time under the Login tab.
1. Check the "Deny Login After ---- Minutes" option.
2. Enter the number of minutes that participants have to log in.
For example, you have select to deny log in after 5 minutes. After 5 minutes has passed,
participants who try to log in will be denied.

52 Presentation Features

Function Bar

The Function bar displays the Response Graph, Pick, and Re-Pose buttons. The Function bar is
optional and is normally used if the instructor remote will not be in use during
presentation. To view the Function bar during presentation, select "Show Function Bar"in

Display tab.
-,
i & "
Response Graph

Click on the !'I!ﬂ Response Graph button.

The Response Graph appears.

Click on the available chart(s) to view the results.

Double-click on the title bar of the window to display the graph in full screen.

N =

Picking Participants

1. Click on the S&f Pick button to randomly call upon a participant.
2. The participant's name will appear on screen.

3. Clickonthe % Pick button again to remove the name.
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Re-posing a Question

Re-posing is used to ask a question again and/or when you accidentally skip a slide that
needs to be answered. Re-posing the question overwrites the previous responses if any are
recorded.

1. Click on the %

Response Indicator

0% 0/0

The response indicator displays the percentage of participants that have answered.
In the Presentation Setup window:
1. Check the "Display Response Indicator" box in the Display tab.
2. In presentation mode, you can move the response indicator by clicking on it with
the mouse and dragging it to another area of the screen.
3. Tochange the indicator view, double-click on it to display responses as fractions.
4. Double-click again to change indicator back to percentage.

Re-pose button to ask the question on the slide again.

Start/Stop Indicator
'Y I,»-*.‘"-x.,l
[ | I"\.___;"

The start/stop indicator resets the time and reposes the question.
1. Check the "Show 'Start/Stop responding to questions indicator" box in the Display tab
of the Presentation Setup window.

Timer
To view the timer during presentation, click on the Timer drop-down list in the General tab
to view the timer options. Here are a few tips on using the timer:

e The timer has pause/play, stop, and add/subtract five seconds options.

¢ You can move the timer by clicking on it and dragging it to another area of the

screen.

e Remotes will not be able to answer when time is up.
You can set the timer two ways; use the time from each slide or apply a new time to the
presentation. When you create a slide, you enter the amount of time you want the slide to
display for.
To set a new time to the presentation:

1. Click on the Timer drop-down list and select "Use Global Timer Value of..."

2. Enter the number of seconds.

3. Click on OKto present the presentation with the newly set time.

Points
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You can set the point value two ways; use the point value from each slide or apply a new
point value to all the questions in the presentation. When you create a slide, you enter the
number of points the correct response will be awarded. Go to Creatingi@lSlide for more
information.
To apply a new point value to all the questions in the presentation:

1. Check the "Override Point Value with Global Point value of ---- points" option.

2. Enter the number of points.

3. Click on OK to present the presentation with the newly set time.

Right/Wrong Feedback
This allows participants to see if their response is right or wrong.

1. Check the "Send Right/Wrong Feedback to Remotes after answering" box in the

General tab of the Presentation Setup window.

Feedback will appear on the LCD screen of the participant's remote during presentation. A
check mark will indicate a correct response, an X will indicate an incorrect response. If the
feedback is disabled, a check mark and X will appear on the LCD screen indicating that a
response was received.

5.2.1 Posing Spontaneous Questions

Spontaneous questions can be posed during presentation with the instructor remote.

Pose Spontaneous Question (with Q5RF Instructor Remote)
An activity must be in presentation mode before following the instructions below.
1. Pressthe New Q key on the instructor remote. A list of question types will appear.
2. Use the thumb pad to scroll through the different question types.
3. Press the Circle (thumb pad) key to select the question type you want to pose.
e The answer choices will appear for Multiple Choice, Yes/No, True/False, and
Multiple Mark. Select the correct answer and press the Send key.
e  For Numeric, Sequence, and Short Answer, you will need to enter the answer.
Enter the answer and press the Send key.
e For survey questions (no correct answer), press the Send key without
selecting an answer.
4. Participants will either see the answer choices or a blank on their remotes. At this
time, they would select or enter their response and press the Send key to confirm.
5.  After all participants have responded, press the Public Graph [ /] key to display the
response graph. Press the Public Graph [ /] again to close the response graph.
Spontaneous data will be recorded if you chose to save the results.

Pose Question (with Q7RF Instructor Tablet)
An activity must be in presentation mode before following the instructions below.

Qwizdom Connect 2008



Qwizdom Connect User Guide

. Qnl ~ . . . .
1. Clickonthe % New Question drop-down arrow. A list of question types will
appear on the remote's LCD screen.

2. Use the up and down arrows to scroll through the list of question types.

3. Press the Enter key to select the question type you want to pose.

4. Select or enter the correct answer.

5. Clickon the > Pose icon.

6. Participants will either see the answer choices or a blank on their remotes. At this

time, they would select or enter their response and press the Send key to confirm.
7. Click on the @Stop icon when time is up or after everyone has responded.

8. Clickon thellill public Graph icon to display the response graph. Click on the
Public Graph icon again to close the response graph.

Quick Pose Question (with Q7RF Instructor Tablet)
1. Using the pen, touch on any answer on the bottom of the tablet.
¢ If you are posing a numeric question, touch the answer and then press the
Enter key to send it.
e If you are posing a survey (no answer) question, touch the Any icon for the
specific question type.

2. (lickon the > Pose icon.
3. Participants will either see the answer choices or a blank on their remotes. At this
time, they would select or enter their response and press the Send key to confirm.

4. Clickonthe @Stop icon when time is up or after everyone has responded.

5. Click on the llill public Graph icon to display the response graph.

Pose Spontaneous Question (without Instructor Remote)
An activity must be in presentation mode before following the instructions below.

. Q. - .
1. Clickonthe “ % New Question drop-down arrow.

2. Select the question type you want to pose.

3. Select or enter the correct answer.

4. C(lickon the > Pose icon.

5. Participants will either see the answer choices or a blank on their remotes. At this
time, they would select or enter their response and press the Send key to confirm.

6. Click onthe @Stop icon when time is up or after everyone has responded.

@ Check the "Show Function Toolbar" box in the Presentation Setup window to
display the Response Graph, Pick, and Repose buttons during presentation.
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7. Click on the Iﬂ Public Graph icon to display the response graph.

5.2.2 Response Graph

During presentation, you can display a response graph to see the results of the question.
There are two response graphs you can display: the public response graph and the private
graph.

Public Response Graph
1. Press the /key on the RF instructor remote.
2. The response graph will appear on screen for the participants to view.
3. Press the right/left arrows to view a different graph of the results.
4. Press the /key again to remove the response graph.

m If you have a graph displayed, either on the instructor remote or computer, you
must first remove that graph before displaying the other graph and/or move
onto the next question.

Bar Chart

[f:_mm Flash Graph - Question Number: 1 =JoJEd

Frint elart (5raph Layout
[ @ * o
B

10

-

C [#]

Correct Answer(s) 10/13 (77%)

Press circle key to show bars horizontally or vertically.

Pie Chart Displaying Correct Answer with Number of Responses
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rd G (2 responses)
)

2.8 (1 response)

4, D (10 responses) -

Correct Answer(s) 10013 (77%)

Pie Chart Displaying Correct Answer with Percentages

5 Ohwiz dom wh Graph - Question Humber:

3G (15%)

2.8 (8%}

4. O (77%)-

Correct Answer(s) 10013 (77%)

Pie Chart Displaying Number of Responses
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3. € (2 responses)

2.8 (1 response)

Answer Responses 13/13 (100%)

Pie Chart Displ

ayin

£

9

Number of Responses

Prink  Select Graph Layout

Gﬂ!

t‘ r-;-
P il

3. € (15%)

2.8 (8%)

Answer Responses 13/13 (100%)

List View Chart
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Prik  Sebect Graph Layout

0O K ©

Wi
Remote I[] Panicipant || Mame Selected | Response Tim | Conrect Answer
10 |10 Peg Verer o |en3s o
12 |2 Matt Owans D |e0s4 £
13 13 Parlicipan: 013 o 6084 L
" 1 Nl Bryart B |ea ]
6 & Suzin Marsch o B30 o
7 |7 Stephan Bouder D |eazm £l
4 -] Tarya Demotla G B4.07 L
5 G Chelsi Peterson o |es3 o
8 8 Cathy Robars ] B5.53 ¥
i (1 Jeriny Madrid D |e851 £l
4 4 Dan Kellis D £5.03 L
2 |2 Andy Patter c |e765 ]
3 | 3 Jaci Mendrix 1] £8.25 Ly
I

Scores Chart

Prik  Sebect Graph Layout

0O K ©

Remote I[] Panicipant || Mame Total Points | Parcontage
3 |2 Jaci Hendix 1 100
12 |2 Matt Owans 1 100
4 4 Dan Kellis 1 100
1 [ Juriny Madrid 1 100
a g Cathy Robers 1 100
5 |s Chelsi Potarsan 1 100
13 13 Partcipant 013 1 100
7 |7 Stephen Boulder 1 100
B [ Suzie Marzch 1 100
10 |10 Peg Verter 1 100
] a2 Tanya Demotio a o

2 |2 Andy Pater 0 0
1 | 1 Mail Bryard 0 ]

Private Response Graph

1. Press the 0 key on the RF instructor remote.
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2.

3.

A bar chart showing the number of responses will display on the RF instructor
remote's LCD screen.
Press the 0 key again to remove the graph.

6 Participants

'8 Participant Wizard

. ’ Welcome to the Participant Wizard

Please specily whal you would ke 1o do
() Craate Mew Paiticipan List
Harne

() Browse and Modily Existing List

Mame

) Impoit

l Mext ]l Cancel ]

Creating a Participant List

1.

vk wnN

Click on the Participants tab.

Click on the & Participant Wizard button. The Participant wizard will appear.
Select "Create New Participant List."

Enter a name for the class and click on Next.

In the Template Selection, select the template you would like to use (optional).

m Remote ID is a default column within the templates. You do not need to create a
field for the Remote IDs, otherwise you will have two Remote ID columns.
Templates are commonly used fields to allow you to customize a participant list
you create or an existing one.

6.
7.

0.
10
11.

Select a template (optional) and click on Next.

Select the different fields you would like to use and click on Next. If you do not see
a field you would like in the participant list, you can create a customized field and
add it to your template.

If you want to create groups, enter the name of the group in the "Create a new
group"field and click on Add. The name of the group will appear in the "Use the
following Groups" column. Skip to the next step if you do not want to create
groups.

Click on Next. The participant template will appear.

Fill in the fields and click on Finish. The Save As window will open.

Click on Save and the participant list will save as a .QPL file.
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Importing a .CSV (Comma Separated Values) File
You can import .CSV class and convert it into Qwizdom participant lists (.QPL).

@ If you have a class list in Microsoft Excel® you would like to import, save them as
.CSVfiles.

1.

ok wWwN

~

8.

Click on the Participants tab.

.}
Click on the E Participant Wizard button. The Participant wizard will appear.
Select Import from a .CSV file.

Click on the L) Browse button. The Open window will appear.

Search for the .CSV file you want to import.

Select the .CSV file and click on Open. The name of the class file will appear in the
Name field.

Click on Next. You will be taken to Template Selection.

Select a template (optional) and click on Next.

m When importing the participant's gender, the code for the gender should be
either M or True for male and F or False for females.

0.

10.

11.

12.

13.
14.
15.

16.

Match the fields on the left to the fields on the right. If you don't know what the
field is, select None. Templates are commonly used fields to allow you to
customize a participant list you create or an existing one. You can also use the
predefined ones that are available.

If the information on the left are headers, check the "First Record is Header" box,
otherwise leave it unchecked. For example, if the imported information on the left
shows column headers such as Last Name, First Name, Remote ID, etc., those are
headers so you would check the "First Record is Header" box. If the information on
the left show the actual name, Remote ID, etc., uncheck "First Record is Header"
because those are not headers.

Click on Next when all the fields have been matched. You will be taken to Group
Selection.

If you want to create groups, enter the name of the group in the 'Create a new
group' field and click on Add. The name of the group will appear in the "Use the
following Groups" column. Skip to the next step if you do not want to create
groups.

Click on Next. The class list will appear.

Click on Finish and the Save As window will appear.

Type in the class name and click on Save. The .CSV class will save as a .QPL file
(Qwizdom Participant List).

Click on Save. The participant list will be available for you to select when you go
into presentation mode.

Creating an Anonymous List
Before using an anonymous list, be sure you have the correct estimated number of
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remotes set within the Configurations Settings window. For example, if you create an
anonymous list with a hundred participants but only have eighty as the estimated number
of remotes, then not all remotes will register.

1. Select an activity, answer key, etc. to present.

Click on the A Present button. The Presentation Setup window will appear.
Click on the Participant List drop-down list and select Anonymous.
Enter in the number of participants. The anonymous list has been created.

HwN

E In Configuration Settings, check to make sure the estimated maximum number
of remotes reflects the number of the participants (or higher). e.g If you have 32
participants but 24 as the estimated maximum number of remotes, then only 24
remotes will be allowed.

5. Click OK to begin presentation.

Editing an Existing Participant List
1. Select the Participants tab.

.,
Click on the E Participant Wizard button. The Participant wizard will appear.
Select "Browse and Modify Existing List."

Click on the l:] Browse button. The Open window will appear.

Search for the participant list you want to edit.

Select it and click on Open. The name of the participant list will appear in the

Name field.

7. Click on Next. You will be taken to Participant Field Selection. You may add new
fields or remove existing fields. If you do not want to change anything, skip to the
next step.

8. Click on Next. You will be taken to Group Selection. You may add new groups or
remove existing groups. If you do not want to change anything, skip to the next
step.

9. Click on Next. The participant list will appear.

ok wWwN

E You can renumber the remotes in order of any column you click on to order by
going to Options (in the Participant Wizard window) and selecting Autonumber
Remotes.

10. Make the necessary changes and click on Finish when done. The Save As window
will appear.
11. Enter the name of the class and click on Save.

Importing Class Lists from Interact
1. Click on the Participants tab .
2. Go to the File menu and select Import.
3. Select Import Classes from Interact. The Interact Import window appears.
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4. Select the class(es) you want to import and click on Import.
5. The classes will import into the tree in the Participants window.
6.1 Groups
Groups are necessary for certain games.
Creating Groups
1. Click on the Participants tab. The Users/Participants window appears.
2. Select the class, in the Class drop-down menu, you want to create groups for.
3. C(Clickonthe j Groups button. The Group Management window will open.
4. Inthe Automatic Grouping Options tab, select the Grouping Action.
e Balance-groups students by ability
e Group Similar-groups students evenly; one team may be odd depending on
the number of students in your class
¢ Random-groups students randomly; groups may be odd/even
e Group Size-specify the number of students in each group
Assign Members Based On-you are able to assign partners based on ability and
performance
e Activity Score-based on overall grade on a particular activity
Select an Activity-use this drop-down menu to select the activity when you are
assigning partners based on selected activity performance.
e Predefined Ability Rating-based on participants capability of learning
5. Under Grouping Action, select Balance.
6. Select Overall Performance under Assign Members Based On.
7. Click on Generate and then click on Done when finished.
Click on a student and then drag and drop the selected student into the desired group.
6.2  Seating

The seating chart is used to track student seating and needs to be completed to take
attendance. See Attendance for more information.

1.

2.

vikhw

Select the class you want to setup the seating chart for.

Click on the ﬂ Seating Chart button to bring up the seating chart. The Seating
Chart window appears.

Student names will be in a column on the right.

Click and drag the name of a student to place them onto the seating chart.
Click on OK when you are finished.
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6.3 Attendance

The seating chart must be completed before you start taking attendance. See
SeatinglChart for more information.

1.

vk wnN

Select the class you want to take attendance for.

Click on the u Attendance button. The Attendance window will appear.
Click on the Layout or List tab.

Mark the attendance of each student by clicking on the student name.
Click on OK when finished.

Attendance by Remote Login

1.

W

© N,

Select the class you want to take attendance in.

Click on the u Attendance button. The Attendance window will appear.

Click on the Layout or List tab.

Click on the Host drop-down list and select the COM number the host is on. The
Session ID will automatically appear in the SessionlD field.

Using the RF remotes to log in, press the Menu key.

Select Login and press the Send (double arrows) key.

The students would enter their ID and press the Send (double arrows) key.

Click on OK when finished.

7 Results

You can generate reports* using existing saved results.

*Registered version of Microsoft Excel® is required to generate reports.
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& Reporting Wizard EJ

Generabe a repoit from the following file
Excel Reports | Flash Repoits

() Areewees Flepont () Atendance Fleport

() Arvevees Diistiibution Repost (7 Participant Detal Repaot

() Scoee Repoit

Export
) Expont 1o Cs 3
Ophonz
[[] Devetride the Point value of all shdes to be paints.
I Generate I [ Done [

1. Click on the Results tab.

2. Click on the H Report Wizard button. The Reporting Wizard window will appear.
3. Click on the Browse button to search for the file you want to generate a report for.
The Open window will appear.
4. The file type will be .QRX. Search for the file and select it.
Click on Open.

Select the type of report you want to generate and click OK. Microsoft Excel® will
open to generate the report.

7. In Microsoft Excel®, go to the File menu and select Save to save the report.

Report Features

Excel® Reports:

e Answer Report-displays bar chart and lists participant names, ID, and remote ID with
score and breakdown of responses for each question.

e Answer Distribution Report-shows a percentage for each answer choice, correct
answer, percentage of correct answers, and the average of the answer sent for each
question.

e Score Report-displays bar chart and shows the participant information with the
number of correct responses out of the total number of questions answered and in
the presentation. Also, shows score and spontaneous question totals.

e Attendance Report-displays participant information with their remote login time,
number of questions answered and total questions.

e Participant Detail Report-displays detailed participant information such as name,
ID, and group number.

Qwizdom Connect 2008



Results 44

Flash Reports:
e Answer Report-displays each question slide with the user's response and the correct
answer.
e Question Summary (with Answer)-displays each question slide with response
charts, marking the correct answer in green.
e Question Summary (without Answer)-display each question slide with response
charts.

Export:
e Convert to .CSV-selecting this options converts the .QRX file into a .CSV.

Options:
e Override the Point value of all slides to be "----" points-overrides point value that
was awarded during presentation.

Quick Mark Grid

This feature is used for manually editing a results file. Use for make up tests and adding
absent students.

1. Click on the Results tab.
2. Select aresults file.

3. C(lickonthe Q Quick Mark/Regrade button. The Paper-Based Score Entry window
appears.

4. Click on a response to change the feedback (right/wrong).

5. Click on OK when finished. The revised score will display in the results file.

8 Answer Key

Creating an Answer Key
1. Go to the Programs menu and select Answer Key. The Answer Key Maker window

appears.
2. Clickonthe < New Answer Key button.
e
3. Clickonthe® Insert a Question button.
4. Select the question type and answer.
5. Setthe number of points.
if_'ud'.
6. Clickonthe: Insert a Question button and repeat steps 3-5.

@ If you delete a question or if the numbering is not in sequential order, go to the
Tools menu to select Renumber Questions to correct.
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7. When the answer key is complete, click on the H Save button. The Save As
window will appear.

8. Select the location the answer key will be saved and enter a name.

9. Click on Save when done. The answer key will save as a .QAK file.

Presenting an Answer Key

fim
1. Click onthe :;lj Open button. The Open window appears.
2. Select the answer key you want to present and click on Open.
3. The answer key will appear.

4. Click onthe Q Present button.

5. The Presentation Setup window appears.

6. Click on the Participant List drop-down arrow and select what type of participant
list you would like to use.

7. Click on the Saved Results drop-down arrow and select how you would like to save
the results.

8. Select the options you would like available during presentation in the General,
Login, and Display tabs in the lower part of the Presentation Setup window.

9. Click on OKto begin the presentation.

10. The Privacy Screen appears.

@ Click on the Red X to show a grid of all the participants and their progress.
11. The answer key will load into the remote. _
12. When all answer keys have been completed, click on the MJ End Session
button.
13. You will be taken back to the Answer Key Maker window.
14. The saved results will save in the location you selected.

Presenting Odd-Numbered Questions

i
Click on the @ Open button. The Open window appears.
Select the answer key you want to present and click on Open.
The answer key will appear.
Go to the Edit menu and select "Select Odd." Only the odd-numbered questions will

be checked.
Click on the J Present button.

6. Participants will only answer the odd-numbered questions during their answer
key.

N =

b

Presenting Even-Numbered Questions
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2y

Click on the \]‘J Open button. The Open window appears.

Select the answer key you want to present and click on Open.

The answer key will appear.

Go to the Edit menu and select "Select Even." Only the even-numbered questions
will be checked.

Click on the i Present button.
6. Participants will only answer the even-numbered questions during their answer
key.

N =

b

Presenting Selected Question Numbers

i

iy

1. Click on the Open button. The Open window appears.

2. Select the answer key you want to present and click on Open.

3. The answer key will appear.

4. Check the question numbers you want to present.

5. Clickon the Q Present button.

6. Participants will only answer the selected question numbers during their answer

key.
Presenting Multiple Answer Keys

2y

1. Click on the \]‘J Open button. The Open window appears.

2. Select an answer key and click on Open.

3. The answer key will open with the Test Number (Activity ID) in the title bar of the
window.

4. Write down the test number (activity ID).

5. Open another answer key and do the same.

6. Click on the black arrow to the right of the Present button.

7. Select Present Multiple Answer Keys.

8. The Browse for Folder window appears.

9. Select the location of the answer keys. With multiple answer keys, they must be
saved in the same location (i.e. Desktop, My Documents, etc.).

10. Click on OK and the Presentation Setup window will appear.

11. Click on the Participant List drop-down arrow and select what type of participant
list you would like to use.

12. Click on the Saved Results drop-down arrow and select how you would like to save
the results.

13. Select the options you would like available during presentation in the General,
Login, and Display tabs in the lower part of the Presentation Setup window.

14. Click on OK to begin the presentation.
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15. The Privacy Screen appears.
16. Activity ID will appear on the participant's remote LCD screen.

@ An activity ID is the answer key test number. Double-click on the answer key to
launch Answer Key to view the test number. Write down the test number for
each answer key for participants to enter.

17. Enter the test number (activity ID) of the answer key into the remote and press the
Send key.
18. The answer key will load into the remote.

@ Click on the Red X to show a grid of all the participants and their progress.

19. When all answer keys have been completed, click on the M] End Session
button.

20. You will be taken back to the Answer Key Maker window.

21. The saved results will save in the location you selected.

Generating a Report for an Answer Key
1. Go to the Tools menu and select Reporting. The Reporting Wizard window appears.
Click on the Browse button. The Open window appears.
Search for the saved results and select it.
Click on Open.
Select a report type.
Click on the Generate button.

N ouwukwnN

Microsoft Excel® will open displaying the saved results in report form.

9 Qwizdom Actionpoint

There are two ways to launch Qwizdom Actionpoint.
e Go to the Programs menu and select Actionpoint.
e Right-click on the Qwizdom Connect tray icon and select Actionpoint.

Microsoft PowerPoint® will open displaying the Qwizdom Actionpoint toolbar.

9.1 Actionpoint Overview

@ | Insert Slide = | Question: Mone + Tvpe: + Answer: - | Poinks: 0 = Timersd None « e d oo @

From right to left:
Present (Actionpoint icon) button -presentation setup
Insert Slide-create a new slide
Question -displays slide type
Type-number of choices (applicable depending on question type)
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Answer-correct answer or None for survey

Points-number of points awarded for correct response

Timer-allows slide to be viewed in presentation for time that is set
Configuration Settings button-remote setup

Participants button-create, modify, import participant lists

Reports button-upload saved presentation results to generate reports using

Microsoft Excel®

Settings button-additional options for Actionpoint
About button-displays software version number

9.2 Slides

1. Go to the Programs menu and select Actionpoint. Microsoft PowerPoint® will open.

Click on the F# 3198 ™ 1 cert Slide drop-down menu.

Select the type of slide you want to create. The template will appear on the slide.
The Question field will indicate the slide format.

If you selected Multiple Choice, Sequence, Multiple Mark, or Rating Scale as the slide
format, the Type drop-down menu will show the number of choices you selected. If
not, the Type field will be grayed out because it doesn't apply to the question type
you selected.

6. Type in the question and choices (if applicable).

7. After the question has been created, click on the Answer drop-down menu and
select or type the correct answer.

ik wnN

ﬁ If you type the answer into the Answer field, press the Enter key on the keyboard
to saveit.

8. Click on the Points drop-down menu and select the point value or type in the
desired point value and press the Enter key on the keyboard to apply the point
value to the slide.

9. Click on the Timer drop-down menu and select the time or type in the desired time
limit and press the Enter key on the keyboard to apply the time to the slide.
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9.3 Participants

*2 Participant Wizard

] ’ Welcome to the Participant Wizard

Please specify what you would e 1o do
(%) Creats Mew Paiticipan List
Harme

() Browse and Modily Existing List

Mame

) Impiot

l Pt H Cancel ]

Creating a Participant List

1.
2.
3.
4.

Click on the 2 Participant button. The Participant wizard will appear.

Select "Create New Participant List."

Enter a name for the class and click on Next.

In the Template Selection, select the template you would like to use (optional).

m Remote ID is a default column within the templates. You do not need to create a
field for the Remote IDs, otherwise you will have two Remote ID columns.
Templates are commonly used fields to allow you to customize a participant list
you create or an existing one. You can also use the predefined templates that
are available.

5.
6.

0.

10.

Select a template (optional) and click on Next.

Select the different fields you would like to use and click on Next. If you do not see
a field you would like in the participant list, you can create a customized field and
add it to your template.

If you want to create groups, enter the name of the group in the "Create a new
group"field and click on Add. The name of the group will appear in the "Use the
following Groups" column. Skip to the next step if you do not want to create
groups.

Click on Next. The participant template will appear.

Fill in the fields and click on Finish. The Save As window will open.

Click on Save and the participant list will save as a .QPL file.

Importing a .CSV (Comma Separated Values) File
You can import .CSV class and convert it into Qwizdom participant lists (.QPL).
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m If you have a class list in Microsoft Excel® you would like to import, save them as
.CSVfiles.

bk w N~

N o

Click on the <@ Participant button. The Participant wizard will appear.
Select Import from a .CSV file.

Click on the L Browse button. The Open window will appear.

Search for the .CSV file you want to import.

Select the .CSV file and click on Open. The name of the class file will appear in the
Name field.

Click on Next. You will be taken to Template Selection.

Select a template (optional) and click on Next. If you are importing a class list from
Qwizdom Actionpoint, you will need to select a template and click on Next. You will
be taken to the Import from CSV window.

@ When importing the participant's gender, the code for the gender should be
either M or True for male and F or False for females

8.

10.

11.

12.
13.
14.

15.

Match the fields on the left to the fields on the right. If you don't know what the
field is, select None. Templates are commonly used fields to allow you to
customize a participant list you create or an existing one. You can also use the
predefined ones that are available.

If the information on the left are headers, check the "First Record is Header" box,
otherwise leave it unchecked. For example, if the imported information on the left
shows column headers such as Last Name, First Name, Remote ID, etc., those are
headers so you would check the "First Record is Header" box. If the information on
the left show the actual name, Remote ID, etc., uncheck "First Record is Header"
because those are not headers.

Click on Next when all the fields have been matched. You will be taken to Group
Selection.

If you want to create groups, enter the name of the group in the 'Create a new
group' field and click on Add. The name of the group will appear in the "Use the
following Groups" column. Skip to the next step if you do not want to create
groups.

Click on Next. The class list will appear.

Click on Finish and the Save As window will appear.

Type in the class name and click on Save. The .CSV class will save as a .QPL file
(Qwizdom Participant List).

Click on Save. The participant list will be available for you to select when you go
into presentation mode.

Creating an Anonymous List

Before using an anonymous list, be sure you have the correct estimated number of
remotes set within the Configurations Settings window. For example, if you create an
anonymous list with a hundred participants but only have eighty as the estimated number
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of remotes, then not all remotes will register.

1. Open a PowerPoint® presentation (that has been properly formatted with the
Qwizdom Actionpoint toolbar).
Click on the || Present button. The Presentation Setup window will appear.

Click on the Participant List drop-down list and select Anonymous.
Enter in the number of participants. The anonymous list has been created.

HwnN

ﬁ In Configuration Settings, check to make sure the estimated maximum number
of remotes reflects the number of the participants (or higher). e.g If you have 32
participants but 24 as the estimated maximum number of remotes, then only 24
remotes will be allowed.

5. Click OK to begin presentation.

Editing an Existing Participant List

1. Click onthe 2 Participant button. The Participant wizard will appear.

2. Select "Browse and Modify Existing List."

3. Clickonthe l:] Browse button. The Open window will appear.

4. Search for the participant list you want to edit.

5. Selectitand click on Open. The name of the participant list will appear in the
Name field.

6. Click on Next. You will be taken to Participant Field Selection. You may add new

fields or remove existing fields. If you do not want to change anything, skip to the
next step.

7. Click on Next. You will be taken to Group Selection. You may add new groups or
remove existing groups. If you do not want to change anything, skip to the next
step.

8. Click on Next. The participant list will appear.

ﬁ You can renumber the remotes in order of any column you click on to order by
going to Options (in the Participant Wizard window) and selecting Autonumber
Remotes.

9. Make the necessary changes and click on Finish when done. The Save As window
will appear.
10. Enter the name of the class and click on Save.

9.4 Remote Setup

Follow the steps below to set up remotes. Be sure the RF host* is properly installed before
proceeding.
v.938 host or higher is required for Qwizdom Connect. If the host is not v.938 host or higher, please contact
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Technical Support to update your hardware.

B Configuration Settings

Genenc Seltings Sedech pour Remobe Types
E stirnated M azinurm Mumbes of Remobe: | 100 a2
Enable Eack-Light on 05 Remates [+ 04
05

‘wihal kind ol rernobe configuration would youw Be bo uge?
(%) Fined Set

Mehen used &z a fved seb the remobes ae configured bo sbeays look for a fived Sezsion ID. Each
Femobe will abwayps retain the same Remobe 1D,

Assrign

() Roaming Set f Participant Dwnead

The paihicipant ownz the Remabe and the Remaote will ask which Sexnon to join IF there iz 4
FemotelD predefmed for & paiticpant. # val be assigried o tham, Otherwse 5 rew random
RemobelD will be sxngred i the devece

[ ok || Concal |

Estimated Maximum Number of Remotes-the number of remotes that will
be in use for presentation. Class/group sizes vary, so it's best to enter the
highest estimated amount of remotes rather than accommodating each
class/group.

Enable Backlight-activates the back light on the Q5RF participant and
instructor remotes.

Fixed Set-select this mode if you are K-12 or Corporate setting. Fixed Set is
where the remotes are assigned with an internal number (assigning fixed
numbers) where logging in by ID is mandatory.

Roaming Set or Participant Owned-check this option if the participants own
the remotes. This mode is best-suited for Higher Ed/University settings.
Participants are required to either enter a Session ID or Participant ID to join a
presentation.

1. Click on the Remotes menu; or right-click on the Qwizdom Connect tray icon, select
Preferences, and then click on Remote Settings. The Configuration Settings window

appears.

2. Enter an estimated number of remotes that will be used.

3. Depending on the setting, select Fixed Set or Roaming Set/Participant Owned.
4. Clickon OK.

Session IDs

When using RF remotes for the first time, the remotes may ask for a Session ID. Each host
has a unique six-digit Session ID. Session IDs "assign" the remote to the host allowing the
remote to only communicates with that specific host. Session IDs are found on the bottom
of the RF Host and within the Configuration Settings window.
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You can also create your own Session ID. The Session ID must be unique because if of there
are other hosts in the same building, the remotes will become confused as to which host
to communicate with. If you are using a fixed set, Session IDs only need to be entered in
once. If you switch hosts or use remotes from another set, you will need to enter the
Session ID, for the host you will be using, into the remotes.

Assigning Fixed Numbers
If Fixed Set mode was selected, then you would assigned fixed numbers to the remotes if
the participants will not be logging in by Participant ID. Assigning fixed numbers assigns
the remote ID (e.g. remote #1, remote #2, etc.). The file that contains the remote
assignments are saved onto the computer, not the actual remote. You only have to assign
fixed numbers once unless you change computers or hosts.

1. Go to the Remotes menu. The Configuration Settings window appears.

2. Enter the estimated number of remotes that will be in use.

3. Select Fixed Set.

4. Click on the Assign button. The Remote Assignment window will appear.

5. Click on the Host drop-down menu and select the COM number (of the host) you
will be using. The Session ID will automatically appear in the Session ID field.

6. Click on the Start button.

7. Turn on the remotes and enter the Session ID. When the remotes communicate

with the host, the number of the remote (with a remote image) will appear in the
window. The Remote ID will also appear on the remote.

8.  After all the remotes have been assigned, click on Stop.

9. Ifyou are not using multiple hosts, skip to step 15. If you are using multiple hosts,
continue to step 10.

10. Click on the Host drop-down menu and select the COM number of the other host
you will be using.

11. The Session ID will automatically appear in the Session ID field.

12. Click on the Start button.

13. Turn on the remotes and enter the Session ID. The remotes will be assigned to this
host only.

14. When the remotes have been assigned fixed numbers, click on the Stop button.

15. Click OK to save and exit the Remote Assignment window.

16. Click OK to save and exit the Configuration Settings window.

Changing Session IDs
If the RF remote displays "No Net," "Not Found," "Not Active," or "Inactive," it could be that
the Session ID is not correct.

e For Q2RF remotes-wait for the remote to time out and turn off. When you turn it
back on, press the Help key. When you see "--5" on the display, it is prompting you
for the Session ID. Enter it and press the Send key to confirm.

e For Q4RF remotes-press the Menu key, use the right arrow to scroll to Sess. ID., and
press the Send (double arrows) key to select the option. You will see the current
Session ID and will be asked if you want to change the Session ID. Press T (Yes) to
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change. Enter the Session ID and press the Send (double arrows) key to send.

For Q5RF remotes-wait for the remote to display "No Net," "Not Active," or "Not
Found." Press the Menu key and select Enter Session ID using the Send (double
arrows) key or the circle key on the thumb pad. Enter the Session ID and press the
Send (double arrows) key.

9.5 Presentation

Before presenting a PowerPoint® presentation using Qwizdom remotes, please see
PresentationiSetupito learn about the presentation features.

Presentation Setup

File

Pasticipant List Browse for Pasticapant List.. 2 | III
Save Resuts Maore [Do nok sawve) W

Present &z 'Mormal Presentaion v

General | Login - Display | Chart
Gerweial 5etlings

[] Send Right\Wrong Feedback to Remaotes after answering,
[] Adlow parficipants to change answer

[] Ovemde Point Vahue with Global Poirt value of [ 1 | points.
Mo Timer ~ econds,
[ ] Do reot uze Qwizdom Remotes (4 ] [ Cancel ]

6.

Click on the ™. Present button.

The Presentation Setup window appears.

Click on the Participant List drop-down arrow and select what type of participant
list you would like to use.

Click on the Saved Results drop-down arrow and select how you would like to save
the results.

Select the options you would like available during presentation in the General,
Login, Display and Chart tabs in the lower part of the Presentation Setup window.
Click on OK to begin the presentation.

E If you present using the PowerPoint® Slide Show options, Qwizdom remotes will

not activate. You must present the slides by clicking on the |2 Present button
to use Qwizdom remotes.
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7. Have the participants turn on their remotes.
8. Either the answer choices or a blank screen appears on the remote, depending on
the question type.
Here are a few things you may execute during presentation:
e Display the response chart by pressing the / key
e Display the private graph by pressing the zero key
e Randomly call upon a participant by pressing the Pick key

@ See UsinglRemotesliniPresentation for description and troubleshooting of all the
remote LCD screen messages.
9. Go through the presentation until all the question slides are answered.
10. When you are unable to advance to the next slide, this means the presentation is
done. Press the circle key in the thumb pad to stop the presentation (screen will go

black) and press it again to exit back to PowerPoint®.

Using Multiple Hosts

Up to 3 hosts (with 1000 remotes on each) can be used for presentation for Q2RF, Q4RF,
and Q5RF.

If you have selected to use fixed set, be sure you have assigned fixed numbers for the
remotes using all RF hosts.

1. Click on the |™. Present button. The Presentation Setup window will appear.

2. Click on the Login tab.

3. Select the hosts you will be using by placing a check mark in each one of the
boxes.

4. You can create your own Session ID in the User Session column or use the default
Session ID.

Q If you use the default Session ID in the Host Session column, the User Session
column must be blank.

5. Click on OK to begin the presentation.

6. When the presentation appears, turn on the remotes.

7. If you assigned fixed numbers, the remotes will automatically log into the correct
host, using the Session IDs used at that time.

8. Enter the appropriate Session IDs into the remotes (including instructor) if
prompted to do so and press the Send key. Press the C (clear) key to delete if you
accidentally mistype a number or see RemotelSetup for more information.

9. Either the answer choices or a blank screen will appear on the remote, depending
on the question type.

Q See UsingiRemotestiniPresentation for description and troubleshooting of all the
remote LCD screen messages.
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9.5.1 Presentation Setup

There are many options you can apply to your presentation. Not all options will be
applicable.

General | Login | Dizplay | Chart
Genaral Setlings

[[] Send Right:wrong Feedback to Remotes afler answeting.

[] Allow paclicspants b change answe

|__ DOwemnde Point Value vath Global Point valee of 1| points.
Ma Tirer o seconds.
General tab:

Send Right/Wrong Feedback to Remotes after answering-remotes will receive a check
mark if answer is correct and an X if answer is incorrect. Remotes will receive both a
check mark and X if feedback is turned off to indicate that the response has been
received.

Allow participants to change answer-checking this option allows participants to
change their answer for the question slide they are on.

Override Points Value with Global Point value of "----" points-enter the new amount
of points that will be applied to the slide temporarily for that presentation.

Timer-you can select no timer, use the time set within the slides, and global timer by
entering the number of seconds for all slides in the presentation.

Gensral| Loan | Dizplay | Chart

Login Setlings Hardware Settngs
[] Require Login by ID Host Host Session LUser Session
[+] Dwszda, 102962 102962
Show Login Scieen

[[] Add and Alow Unregistered participanis

Dremy Login Afber minuhes
Host Mode: Fred to Host

Login tab:
Require Login by ID-checking this option will have remotes prompt participants to
enter their Participant ID.
Show Login Screen-displays the login screen so the instructor can view the participants
that are logging in.
Add & Allow Unregistered participants-participants will be added to the participant by
logging in with their Participant ID. This option must be checked when using an
Anonymous list. For the Anonymous list, participants will only log in with the Session ID.
Deny Login After "----" minutes-logins after the set amount of time will not be
accepted.
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Gensral | Login | Display | Chart
Display Sellings
[[] Shew Function toolbar [net resded i using Preserter Remobe]
[] Dusplay Response Indicator
[] Showe StamiStop rezponding 1o questions indicator

Display tab:
Show function toolbar (not needed if using Presenter Remote)-checking this option
will display toolbar with Response Chart, Pick, and Re-pose buttons.
Display Response Indicator-this displays the percentage of the class that has
answered; double-click the percentage to convert to a fraction.
Show 'Start/Stop'responding to questions indicator-clicking on Stop will pause the

presentation and responses will not be accepted. Clicking on Start reposes the
question.

Gensral| Login | Dizplay | Chait
Chiart Sehlings
] Austomatically Skow Corect Answer on Chart

[[] Backgiound Filensme: [:]

Resporse Giaph wall be dhown az

Sedect Graph Lapout |

Chart tab:
Automatically Show Correct Answer on Chart-checking this option will display toolbar
with Response Chart, Pick, and Re-pose buttons.

Background Filename-selecting this option will allow you to select an image to display
as the response chart background.

Select Graph Layout-select how the response chart will be displayed during
presentation.

Advanced Settings

In the Presentation Setup window, go File and select Advanced Settings. This will bring up
the Advanced Settings window.
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[ﬂ_.‘ Advanced Settings .L]IE

Advanced Settings

[] Aow Instnucto bo go hack fo a previous e
[] Reset ComPoit When Starting Presentation
[T sk foe confmation of Liser 10 when not on

Advanced Hardwae Settings
[[] Don't requite Send on snghe key answers
[] Dizable Thangs UzedD' menu duing Logn
[[] Dizable Thange SessonlD’ menu duning Login
[ Dissble Thange UsedD' menu duing schive Session
[] Dizable Thangs SezsionlD’ meny during actie Session
[] Do it shicwws wabiat kay weas pressed on 02's
[C] Tusn off remotes on presentation end

Lok ][ Coca |

Advanced Settings

o Allow Instructor to go back to a previous slide-checking this option allows the
instructor remote to move back to a previous slide.

e Reset Com-Port When Starting Presentation-this option is checked by default to
ensure the host activates when presentation begins.

o Ask for confirmation of User ID when not on list-the remote will prompt the
participant for the user ID again, if the participant is not in the participant list that is
loaded.

Advanced Hardware Settings

e Don'trequire "Send" on single key answers-the remote will automatically send the
answer once it has been entered.

e Disable "Change UserID" menu during Login-hides the "User ID" option from the
menu.

e Disable "Change SessionID" menu during Login-hides the "Session ID" option from
the menu.

e Disable "Change UserID" menu during active Session-hides the "User ID" option
from the menu during presentation.

e Disable "Change SessionID" menu during active Session-hides the "Session ID"
option from the menu during presentation.

e Do not show what key was pressed on Q2's-does not show the key that is pressed
on the display.

o Turn off remotes on presentation end-automatically turns off the Q2RF and Q4RF
remotes when a presentation ends.

9.5.1.1 Presentation Settings

Presentation settings can be saved and loaded (onto the same computer or another
computer) into the Presentation Setup window of Actionpoint, Answer Key, and Question Bar
applications.
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Saving Presentation Settings
1. In the Presentation Setup window, select the options you would like during
presentation.
2. Goto the File menu and select Save Settings. The Save As window appears.
3. Enter the name for the selected settings.
4, Click on Save. The settings will save as a .CFG file in the location you selected.

Loading Presentation Settings
1. In the Presentation Setup window, go to the File menu.
2. Select Load Presentation Settings. The Open window appears.
3. Select the saved settings file (.CFG) and click on Open.
4. The current settings in the Presentation Setup window will change to the settings
you selected to load.

9.5.1.2 Saving Results
All results are saved as an .QRX file but can be converted into a .CSV (Comma Separated
Values) file.

Manual Save
1. Click onthe IEI Present button. The Presentation Setup window will appear.

2. Select Browse for Save Location.
3. Click on the LI Browse button. The Save As window appears.
4. Select alocation to save the results in.
5. Enter the name you want the results to be saved as.
6. Click on Save. The file name and location will appear in the Save Results field.
7. The results will save in the selected location.
Auto-save

1. Click on the @ Present button. The Presentation Setup window will appear.
Select Auto Save as 'Filename + List + Date.'

The Browse for Folder window appears.

Select the location and click on OK.

The file name will contain the location, name of the participant list, date, and time
under the Save Results field.

6. The results will save when the presentation is complete.

vk wnN

Auto-Save to Results Manager

You must be logged into Qwizdom Online to access this feature.
1. Clickon the EI Present button. The Presentation Setup window will appear.
2. Select Auto Save to Results Manager.
3. The results will save in the Results/Reports window when the presentation is
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complete.

9.5.1.3 Remote Login

Logging in with IDs allows participants to use any remote. If you use Participant IDs from a
participant list, the ID will link the remote to the participant's information in the list.

To have participants log in, they must have a Participant ID. Participant IDs are setup when
creating participant lists. (Go to Participantilists for more information). Each participant
should have a unique ID assigned to their name.

Participant IDs can only be numeric.

The maximum number of digits allowed for IDs using the Q2RF remotes is 8.
The maximum number of digits allowed for IDs using the Q4RF remotes is 9.
The maximum number of digits allowed for IDs using the Q5RF remotes is 8.
IDs cannot be used for more than one participant (IDs cannot be duplicated).

Open a PowerPoint® presentation or create one to present.

Click on the EI Present button. The Presentation Setup window will appear.
Select a participant list from the "Participant List" drop-down menu.
Click on the Login tab.
Check the "Require Login by ID" option.
Checking the "Show Login Screen" is optional.
Select all other preferred options and click on OK to present. The presentation will
begin.
8. The Q4RF and Q5RF remotes will display "User ID." The Q2RF remotes will display "-
-U"
9. Participants will enter their ID and press the Send key.
10. Once everyone has logged in, begin the presentation.
You can start the presentation as participants log in. Participants who are late, can log in
later if you have not set a timer to deny log-in.

Noup,rwhN =

Login Timer
You can deny login after a certain amount of time by setting the time under the Login tab.
1. Check the "Deny Login After ---- Minutes" option.
2. Enter the number of minutes that participants have to log in.
For example, you have select to deny log in after 5 minutes. After 5 minutes has passed,
participants who try to log in will be denied.
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Logging in with Participant IDs
Participant IDs can only be numeric.

Click on the A Present button. The Presentation Setup window will appear.

1.

2. Click on the Login tab.

3. Select "Require Login by ID."

4. Select the participant list and any other options you want to apply to the
presentation.

5. Click on OK to begin the presentation.

6. The Q4RF and Q5RF remotes will display "User ID." The Q2RF remotes will display "-
-U."

7. Enter the Participant ID and press the Send key.

8. If the Q4RF remote displays "Denied;" or the Q5RF remote displays "Access Denied;"
or the Q2RF remote displays "--U," then the Participant ID may have been entered
incorrectly.

e For Q2RF remotes, press the Hand key, re-enter the Participant ID, and press
the Join key.
e For Q4RF remotes, press the Menu key, use the right arrow to scroll to User ID,
and press the Send (double arrows) key to select it. Re-enter the Participant
ID and press the Send (double arrows) key.
e For Q5RF remotes, press the C (clear) key, re-enter the Participant ID, and
press the Send (double arrows) key.
The Participant IDs will be remembered for the session until another participant list is
selected to present to.

9.5.1.4 Presentation Queue

Presentation queues are only for Actionpoint using PowerPoint® presentations.

Use Presentation Queue

1. Click on the IEI Present button. The Presentation Setup window appears.
2. Go to the File menu and select Use Presentation Queue. The Presentation Queue
window appears.

3. Click on Add. The window will change to show three fields: Presentation, Participant
List, and Results.
Click on the Browse button for Presentation. The Open window appears.
Select the presentation and click on Open.
Click on the Browse button for Participant List. The Open window appears.
Select the participant list and click on Open.
Click on the Browse button for Results. The Save As window appears.
Select a location where the results will be saved.

. Enter a name for the results and click on Save.

. Click on Add. You will be taken back to the Presentation Queue window and see
the files you just added.

SV NV A
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12. Repeat steps 4-12 to add another presentation.
13. When you are finished creating your queue, click on Save Queue. The Save As
window appears.
14. Select a location where you would like to save the queue.
15. Enter a name for the queue and click on Save.
16. Click on OK. You will be taken back to the Presentation Setup window.
17. Click on the Participant List drop-down arrow and select what type of participant
list you would like to use.
18. Click on the Saved Results drop-down arrow and select how you would like to save
the results.
19. Select the options you would like available during presentation in the General,
Login, and Display tabs in the lower part of the Presentation Setup window.
20. Click on OK and the queue will start.
21. When the first presentation is complete, exit presentation mode.
22. The results will save as a .QRX file in the selected location with a designated name.
23. The second presentation will begin, on its own, in a few moments.
This process will repeat depending on how many presentations are set in the queue.
Results will be generated after each presentation is closed upon completion.

Loading a Saved Presentation Queue

1. Click on the @ Present button. The Presentation Setup window appears.

2. Go to the File menu and select Use Presentation Queue. The Presentation Queue

window appears.

Click on Load Queue. The Open window appears.

4. Select the queue you want to use and click on Open. The files will appear in the
Presentation Queue window.

5. Click on OK and you will be taken back to the Presentation Setup window.

w

95.2 Presentation Features

Function Bar

The Function bar displays the Response Graph, Pick, and Re-Pose buttons. The Function bar is
optional and is normally used if the instructor remote will not be in use during
presentation. To view the Function bar during presentation, select "Show Function Bar"in

Display tab.
a
i & "
Response Graph

1. Click on the ‘!M Response Graph button.
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2. The Response Graph appears.
3. Click on the available chart(s) to view the results.
4. Double-click on the title bar of the window to display the graph in full screen.

Picking Participants

1. Click on the % Pick button to randomly call upon a participant.
2. The participant's name will appear on screen.

3. (lickonthe % Pick button again to remove the name.

Re-posing a Question

Re-posing is used to ask a question again and/or when you accidentally skip a slide that
needs to be answered. Re-posing the question overwrites the previous responses if any are
recorded.

1. Click on the %

Response Indicator

0% 0/0

The response indicator displays the percentage of participants that have answered.
In the Presentation Setup window:
1. Check the "Display Response Indicator" box in the Display tab.
2. In presentation mode, you can move the response indicator by clicking on it with
the mouse and dragging it to another area of the screen.
3. Tochange the indicator view, double-click on it to display responses as fractions.
4. Double-click again to change indicator back to percentage.

Re-pose button to ask the question on the slide again.

Start/Stop Indicator
» (A
[ | I"\.___;"
The start/stop indicator resets the time and reposes the question.
1. Check the "Show 'Start/Stop responding to questions indicator" box in the Display tab
of the Presentation Setup window.

Timer
To view the timer during presentation, click on the Timer drop-down list in the General tab
to view the timer options. Here are a few tips on using the timer:

e The timer has pause/play, stop, and add/subtract five seconds options.
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e You can move the timer by clicking on it and dragging it to another area of the
screen.

e Remotes will not be able to answer when time is up.
You can set the timer two ways; use the time from each slide or apply a new time to the
presentation. When you create a slide, you enter the amount of time you want the slide to
display for.
To set a new time to the presentation:

1. Click on the Timer drop-down list and select "Use Global Timer Value of..."

2. Enter the number of seconds.

3. Click on OKto present the presentation with the newly set time.

Points
You can set the point value two ways; use the point value from each slide or apply a new
point value to all the questions in the presentation. When you create a slide, you enter the
number of points the correct response will be awarded. Go to Creatingi@lSlide for more
information.
To apply a new point value to all the questions in the presentation:

1. Check the "Override Point Value with Global Point value of ---- points" option.

2. Enter the number of points.

3. (lick on OKto present the presentation with the newly set time.

Right/Wrong Feedback
This allows participants to see if their response is right or wrong.

1. Check the "Send Right/Wrong Feedback to Remotes after answering"” box in the

General tab of the Presentation Setup window.

Feedback will appear on the LCD screen of the participant's remote during presentation. A
check mark will indicate a correct response, an X will indicate an incorrect response. If the
feedback is disabled, a check mark and X will appear on the LCD screen indicating that a
response was received.

9.5.2.1 Response Graph

During presentation, you can display a response graph to see the results of the question.
There are two response graphs you can display: the public response graph and the private
graph.

Public Response Graph
1. Press the / key on the RF instructor remote.
2. The response graph will appear on screen for the participants to view.
3. Press the right/left arrows to view a different graph of the results.
4. Press the / key again to remove the response graph.
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@ If you have a graph displayed, either on the instructor remote or computer, you
must first remove that graph before displaying the other graph and/or move
onto the next question.

Bar Chart
[ Quwizdom Flash Graph - Question Humbar: 1 ==

|| Frink slact iaraph Layouk
| b:‘- J i ﬂ

10

2
- ™
B C [

Correct Answer(s) 10/13 (77%)

Press circle key to show bars horizontally or vertically.

Pie Chart Displaying Correct Answer with Number of Responses
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rd G (2 responses)
)

2.8 (1 response)

4, D (10 responses) -

Correct Answer(s) 10013 (77%)

Pie Chart Displaying Correct Answer with Percentages

b Gra = Qs tion umban:

3G (15%)

2.8 (8%}

4. O (77%)-

Correct Answer(s) 10013 (77%)

Pie Chart Displaying Number of Responses
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Answer Responses 13/13 (100%)

3. € (2 responses)

2.8 (1 response)

Pie Chart Dlsplaymg Number of Responses

Answer Responses 13/13 (100%)

3. € (15%)

2.8 (8%)

List View Chart
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Prink  Select Graph Layout
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Scores Chart

Prik  Sebect Graph Layout

O @ © n @

Remote I[] Panicipant || Mame Total Points | Parcontage
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1 | 1 Mail Bryard 0 ]

Private Response Graph
1. Press the 0 key on the RF instructor remote.
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2. A bar chart showing the number of responses will display on the RF instructor
remote's LCD screen.
3. Press the 0 key again to remove the graph.

9.6 Reports

You can generate reports* using existing saved results.

*Registered version of Microsoft Excel® is required to generate reports.

& Reporting Wizard EJ
Generabe a repoit from the following file

Excel Reports | Flash Repoits

() Areewees Flepont () Atendance Fleport
() Ancweer Distiibugtion Repost (") Parlicipant Detal Repaoit

() Score Report
Export

) Expont 1o Cs 3

Ophonz
[[] Devetride the Point value of all shdes to be paints.

I Generate I[ Done f

1. Click onthe ) Reports button. The Reporting Wizard window will appear.

2. Click on the Browse button to search for the file you want to generate a report for.
The Open window will appear.

The file type will be .QRX. Search for the file and select it.

Click on Open.

> w

5. Select the type of report you want to generate and click OK. Microsoft Excel® will
open to generate the report.

6. In Microsoft Excel®, go to the File menu and select Save to save the report.

Report Features

Excel® Reports:
e Answer Report-displays bar chart and lists participant names, ID, and remote ID with
score and breakdown of responses for each question.
e Answer Distribution Report-shows a percentage for each answer choice, correct

answer, percentage of correct answers, and the average of the answer sent for each
question.

e Score Report-displays bar chart and shows the participant information with the
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number of correct responses out of the total number of questions answered and in
the presentation. Also, shows score and spontaneous question totals.

e Attendance Report-displays participant information with their remote login time,
number of questions answered and total questions.

e Participant Detail Report-displays detailed participant information such as name,
ID, and group number.

Flash Reports:
e Answer Report-displays each question slide with the user's response and the correct
answer.
e Question Summary (with Answer)-displays each question slide with response
charts, marking the correct answer in green.
e Question Summary (without Answer)-display each question slide with response
charts.

Export:
e Convert to .CSV-selecting this options converts the .QRX file into a .CSV.

Options:
e Override the Point value of all slides to be "----" points-overrides point value that
was awarded during presentation.

10  Question Toolbar

Question Toolbar allows you to ask questions, add content, and presentation mark ups on-
the-fly. This tool captures your desktop and sets it as a background to your presentation.
For example, if you have a document open that you wish to use as supplemental material
to enhance your presentation or just simply want to add media or key points
spontaneously, the glass mode feature will take a screen capture of your desktop and set
the screen shot as your background.

Question Toolbar
@- 4 : P‘|Q:§'JQ_ ﬂ'vx%1|

"A-® TS| M-

Type |YesMo w | answer |Mone | | Time |20 2. Paints |5 |

Qwizdom Connect 2008



71 Qwizdom Connect User Guide
i . -
Slide navigator ’, Pen tool
Qa - ) =
“  Create new question / Line tool
| i
I Indicates Information slide J Shapes tool
Qindicates question slide A " Text tool
A indicates answer slide b3 MathML
9 7 Copies current slide as into slide set Insertimage
: LY o
b Pose Questions g Insert multimedia
X : : & Color palett
Deletes a selected object on the slide Lolor palette
@ » Undo/redo EQuestion Toolbar
............. (switch views to Full Screen or Integrated)
.....Selects objects on slide . Expands Toolbar
1. Go to the Programs menu and select Question Toolbar. The Presentation Setup
window appears.
2. Click on the Participant List drop-down arrow and select what type of participant
list you would like to use.
3. Click on the Saved Results drop-down arrow and select how you would like to save
the results.
4. Select the options you would like available during presentation in the General,
Login, and Display tabs in the lower part of the Presentation Setup window.
5. Click on OK to begin the presentation.
6. Have the participants turn on their remotes.
7. Use the Q7RF instructor tablet to access the toolbar to create slides and pose
questions.
8. When you are finished presenting, click on the ®Utilities button and select Exit.
9. A window will appear prompting you to Rename, Delete, or Leave the activity name.
10. Choose Rename and enter a name for the activity. The activity will appear in the
tree of the Content Manager.
11 Qwizdom Online

Qwizdom Online lets you preview, rate, and download activities and multimedia files.

1. Click on the Qwizdom Online tab in the application window.
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2.

Log-in with your username and password.

ﬁ Username is created during registration and the password is provided in the

registration confirmation.

Notifications
Notify other teachers about content you have created and added to the online system.

1.

Click on the ¥ Notification button. The Create Notification window appears.

2. Typein a header along with a message.
3. Select the district or user(s) you would like to notify.
4. Click on the Send button.

11.1 Media

Search the media database for images and movies.

1.

NouhkwnN

Click on the Qwizdom Online tab.

Click on the Media tab.

Enter the keyword(s) in the Keywords field to search for an image.

Click on Search.

Images and multimedia containing the keyword(s) will appear in the Results area.
Select the image or multimedia in the Results area.

Use the drag and drop feature to place the image or multimedia into Live Editor,

PowerPoint®, Keynote®, or another program.

11.2 Content Search

Slmple Keyword Search

NoOUuswWN =

Click on the Qwizdom Online tab.

Click on the Activities tab.

Click on the Search tab.

Enter a keyword into the Keywords field.

Click on Search.

Activities containing the keyword will appear in the Package Name column.
Click on an activity and then press the Preview button.

Advanced Keyword Search
Set search parameters to search by subject and/or grade level.

1.

2.
3.
4

Click on the Qwizdom Online tab.

Click on the Activities tab.

Click on the Search tab.

Click on Advanced Filter and select grade level(s) and subject(s). Click on Close
when finished.

Enter a keyword into the Keywords field.
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6. Click on Search.
7. Activities containing the keyword will appear in the Package Name column.
8. Click on an activity and then press the Preview button.

Browse Content

Click on the Qwizdom Online tab.

Click on the Activities tab.

Click on the Browse tab.

If you wish to browse limited topics based on the user properties that you selected

in the Registration Wizard window during installation process, check the Filter by

user properties box. See InstallinglQwizdomionnect for more information.

5. Select the desired package from the drop-down menu, click on an activity, and
then press the Preview button.

HPwN =

Download Content

Click on the Qwizdom Online tab.

Click on the Activities tab.

Select a package or activity you would like to download.

Click on the Import to Tree button.

To view your the activity, click on the Content Tab and go to your Recently Added
folder in the Content Tree.

nhwnN=

@ Some activities require a license to download, see Activityllicensing for details.

11.3 Rating Activities

Rate content quality on a scale of 1 - 5. The number of stars indicates the average content
rating.

1. Click on the Online tab.

2. Right -click the package or activity that you would like to rate. The Rate Package
window appears.

&° Rate Package E]@W

Fating

Ol el el e @

Ilzer Comments:

Subirmit
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3. Onascale of 1-5 select the quality of package and add you comment to the User
Comment text filed. The comment will be not be displayed but we are happy to
hear what our customers think of the content packages.

4. Press the Submit button when finished.

11.4 Activity Licensing

115

12

Certain activities and curriculum packages require a valid license code, which can be
acquired through the purchase of Qwizdom Connect Premium Service (coming soon).
Restricted content may be previewed but not downloaded.

Licensing Icons

Purchased License- indicates that you have a license to download this content.

[@ Need License- indicates that you need to purchase a license before you can download
content. Contactllis to purchase Qwizdom Connect Premium Service (coming soon).

'Q No License Required- indicates that no license is required to download activity.

Upload an Activity

To upload an activity to the Qwizdom Online:
1. Click on the Content tab.

2. Right-click on the activity you wish to upload into the online system.
3. Select Send to Qwizdom Online.

Settings/Preferences
Go to the File menu and select Preferences. The Preferences window appears.

General Tab

e Auto-start Qwizdom Connect on system start up-checking this option will open
Qwizdom Connect when you're computer starts up.

e Show toolbar on desktop during startup-displays Qwizdom Connect toolbar when
program is launched.

e Auto-login to Qwizdom Connect-automatically logs in with your username and
password when Qwizdom Connect is opened. When this option is checked, you will
be prompted to enter your username and password to store for the auto-login
process.

e Auto-upload results to Qwizdom Connect-must be logged in for feature to enable
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results to be automatically uploaded to the Results/Reports window of Qwizdom

Connect.

e Toolbar Items-uncheck any of these options will remove them from the toolbar.

e Remote Settings-see RFlRemotelSetup for more information.

e Start Registration Wizard-Qwizdom Connect registration.

e Software version number - helpful information to give support technicians when

requesting help.

Standards Tab

1. Select your state standards in the Select State drop-down list.

2. (Click on Download State Standards to download your state standards into Qwizdom

Connect.

Remote Setup

Follow the steps below to set up remotes. Be sure the RF host* is properly installed before

proceeding.

v.938 host or higher is required for Qwizdom Connect. If the host is not v.938 host or higher, please contact

Technical Support to update your hardware.

B Configuration Settings

Genenc Seltings Sedech pour Remobe Types
E stimated M azinum Mumbes of Remotes | 100 =52
[+] Enable Back-Light on 05 Remotes [~] a4
0s

‘wihal kind ol rernobe configuration would youw Be bo uga?
(%) Fved Set

Mafhen used &z a fved seb the remokes s configured bo abeays ook for a fiwed Sezsion 1D, Each
Femobe will abwayps retain the same Remobe 1D,

Assrign

() Rosming Set / Paticipant Dwned

The paihicipant ownz the Remabe and the Remaote will ask which Sexnon to join IF there iz 4
FemotelD predefned for & paticpant, # val be scsigred to them, Dhensse & new random
RemobelD will be sxngred i the devece

[ ok || Concal |

e Estimated Maximum Number of Remotes-the number of remotes that will
be in use for presentation. Class/group sizes vary, so it's best to enter the
highest estimated amount of remotes rather than accommodating each

class/group.

e Enable Backlight-activates the back light on the Q5RF participant and

instructor remotes.
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o Fixed Set-select this mode if you are K-12 or Corporate setting. Fixed Set is
where the remotes are assigned with an internal number (assigning fixed
numbers) where logging in by ID is mandatory.

e Roaming Set or Participant Owned-check this option if the participants own
the remotes. This mode is best-suited for Higher Ed/University settings.
Participants are required to either enter a Session ID or Participant ID to join a
presentation.

1. Click on the Remotes menu; or right-click on the Qwizdom Connect tray icon, select
Preferences, and then click on Remote Settings. The Configuration Settings window
appears.

2. Enter an estimated number of remotes that will be used.

3. Depending on the setting, select Fixed Set or Roaming Set/Participant Owned.

4. Clickon OK.

Session IDs

When using RF remotes for the first time, the remotes may ask for a Session ID. Each host
has a unique six-digit Session ID. Session IDs "assign" the remote to the host allowing the
remote to only communicates with that specific host. Session IDs are found on the bottom
of the RF Host and within the Configuration Settings window.

You can also create your own Session ID. The Session ID must be unique because if of there
are other hosts in the same building, the remotes will become confused as to which host
to communicate with. If you are using a fixed set, Session IDs only need to be entered in
once. If you switch hosts or use remotes from another set, you will need to enter the
Session ID, for the host you will be using, into the remotes.

Assigning Fixed Numbers
If Fixed Set mode was selected, then you would assigned fixed numbers to the remotes if
the participants will not be logging in by Participant ID. Assigning fixed numbers assigns
the remote ID (e.g. remote #1, remote #2, etc.). The file that contains the remote
assignments are saved onto the computer, not the actual remote. You only have to assign
fixed numbers once unless you change computers or hosts.

1. Go to the Remotes menu. The Configuration Settings window appears.

2. Enter the estimated number of remotes that will be in use.

3. Select Fixed Set.

4. Click on the Assign button. The Remote Assignment window will appear.

5. Click on the Host drop-down menu and select the COM number (of the host) you
will be using. The Session ID will automatically appear in the Session ID field.

6. Click on the Start button.

7. Turn on the remotes and enter the Session ID. When the remotes communicate
with the host, the number of the remote (with a remote image) will appear in the
window. The Remote ID will also appear on the remote.

8.  After all the remotes have been assigned, click on Stop.

9. Ifyou are not using multiple hosts, skip to step 15. If you are using multiple hosts,
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continue to step 10.

10. Click on the Host drop-down menu and select the COM number of the other host

you will be using.

11. The Session ID will automatically appear in the Session ID field.

12. Click on the Start button.

13. Turn on the remotes and enter the Session ID. The remotes will be assigned to this

host only.

14. When the remotes have been assigned fixed numbers, click on the Stop button.

15. Click OK to save and exit the Remote Assignment window.

16. Click OK to save and exit the Configuration Settings window.

Changing Session IDs
If the RF remote displays "No Net," "Not Found," "Not Active," or "Inactive," it could be that
the Session ID is not correct.

e For Q2RF remotes-wait for the remote to time out and turn off. When you turn it
back on, press the Help key. When you see "--S" on the display, it is prompting you
for the Session ID. Enter it and press the Send key to confirm.

e For Q4RF remotes-press the Menu key, use the right arrow to scroll to Sess. ID., and
press the Send (double arrows) key to select the option. You will see the current
Session ID and will be asked if you want to change the Session ID. Press T (Yes) to
change. Enter the Session ID and press the Send (double arrows) key to send.

e For Q5RF remotes-wait for the remote to display "No Net," "Not Active," or "Not
Found." Press the Menu key and select Enter Session ID using the Send (double
arrows) key or the circle key on the thumb pad. Enter the Session ID and press the
Send (double arrows) key.

13.1 Notice

FCC15.19:

(3) All other devices shall bear the following statement in a conspicuous
location on the device.

This device complies with Part 15 of the FCC Rules. Operation is subject to
the following two conditions: (1) this device may not cause harmful
interference, ad (2) this device must accept any interference received,
including interference that may cause undesired operation.

FCC15.21:

The users manual or instruction manual for an intentional or unintentional
radiator shall caution the user that changes or modifications not expressly
approved by the party responsible for compliance could void the user's
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authority to operate the equipment. In cases where the manual is provided
only in a form other than paper, such as on a computer disk or over the
Internet, the information required by this section may be included in the
manual in that alternative form, provided the user can reasonably be
expected to have the capability to access information in that form.

FCC 15.105:

13.2 Q2RF

(b) For a Class B digital device or peripheral, the instructions furnished the
user shall include the following or similar statement, placed in a prominent
location in the text of the manual:

NOTE: This equipment has been tested and found to comply with the limits
for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits
are designed to provide reasonable protection against harmful interference
in a residential installation. This equipment generates, uses and can radiate
radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications.
However, there is not guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to
radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

-- Reorient or relocate the receiving antenna.

-- Increase the separation between the equipment and receiver.

-- Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.

-- Consult the dealer or an experienced radio/TV technician for help.

Participant Remote
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This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

1.

w

E ink™ display-displays the remote's ID number when it is turned off; displays
remote's ID number and battery icon when it is turned on.

Navigation @ @ arrows-to scroll through question numbers. Left arrow @

is also used as a backspace.

True/Yes, False/No keys-use to answer True/False and Yes/No questions
Multiple Choice and Numeric keypad-answer multiple choice and numeric
questions (with single digit answers).

Join . key-press to turn remote on/off or confirm Session and/or User IDs.

Help key-press to request assistance or press to change Session ID when the
remote cannot find the host.
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13.3 Q4RF

Participant Remote

%0 ?e) ?e

%0 %9 %

@ © ©

© © @
©

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation..

1.
2.

Send@ key-press to submit answer or select menu options. i
Menu [power] key-press to view menu options (use the scroll GXE) keys to

scroll through options and press Send @ key to select the option). Holding the
Menu button for two seconds will turn the remote on/off. Turn off remotes if they

are not in use. Remotes automatically turn off at the end of a PowerPoint®
presentation. Search, Sess. ID, User ID, and Exit are options available in the Menu.
When you're in presentation, the menu items are Help, Login User Id, and Exit. To
request help during presentation, press the Menu key, scroll to select Help, and

press the Send_@) key to select it.

Scroll keys-to scroll through menu options, answer choices, or question
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13.4

4.

5.

numbers.

Clear [C] key-press to delete response or change answers if instructor has enabled
the feature.

True/Yes and False/No keys--use to answer True/False and Yes/No questions

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

Q5RF

Participant Remote

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation..

1.
2.

Send @ key-press to submit answer

Clear [C] key-press to delete response or change an answer in a presentation (if
option to change responses is allowed)

Thumb pad-press to navigate between letters when keying in answer, press the
circle button in the middle to select a letter or to select menu options or to scroll
through question numbers during answer keys (paper-based tests).

Question [?] key-signals help to instructor during presentation

Menu key-displays menu options Search Again, Enter Session ID, and Exit. Use the

thumb pad to scroll through the menu options and the Send @ key or circle
button to select an option.

True/Yes and False/No keys-use to answer True/False and Yes/No questions
Power switch-turns remote on/off. The remotes do not automatically turn off.
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8.

Turn off remotes if they are not in use.
Light switch-turns Backlight on/off

Instructor Remote (this is the instructor remote for Q4 and Q5 participant remotes)

._IE'

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

1.
2.
3.

0.

Send@ key-press to submit command

C [Clear] key-press to clear names from the Help Request list.

Thumb pad-press right/left to navigate between slide sets, up/down for menu
options, and "on-the-fly" question choices. Press the circle button (in the middle)

to select an option, play Microsoft PowerPoint® animations, advance slides, exit the
presentation, and show/hide correct responses on the response graph.

? [Help List] key-displays list of participants who requested help on the LCD screen
Menu key-view menu options such as entering Session ID and search again for
host

True/Right and False/Wrong keys-not applicable using Qwizdom Actionpoint
New Q [-] key-press to pose an "on-the-fly" question

Pick [.] key-press to display/hide a random participant's name on the computer
screen

Private Graph ll.n [0] key-displays the results of the class responses as a graph on
the LCD screen of the instructor's remote

’ 4
10. Public Graph M-l [/1 key-displays the results of the class responses as a graph on
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the computer (projector, television screen, etc.) screen for everyone to view. Use
the right/left controls on the thumb pad to scroll through the different graphs.
Use the circle button (in middle of thumb pad) to show/hide correct responses.

11. Show [7] key-displays animations during game presentations

12. Play [8] key-pauses or continues a video/sound clip

13. Fn (Function) key-allows you to re-pose a question if you go back during to a
previous slide during presentation-previous answers will be overwritten.

14. Power switch-turns remote on/off

15. Light switch-turns Backlight on/off. The "Enable Backlight" box in the Configuration
Settings window needs to be checked to turn on the Backlight feature.

135 Q7RF

Instructor Tablet
Available Fall 2008

RO SEEl ME .
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This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.
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The Q7RF Instructor Tablet acts as an absolute position mouse, controlling standard
keyboard shortcuts such as:

e copy, paste, and delete

e navigating presentations

@ Qwizdom Connect-launches Qwizdom Connect . Stop-stops the question being

posed
New Item-creates new slide, file, or document il private Graph-displays private
depending on application graph of responses on tablet
B Open-browse and open files Uil Public Graph-displays

response graph to participants

.Open Website-opens computer default browser « LCD Backlight-turns backlight

on or off
3 File Browser-opens file browser window i.f' Pen tool-use to draw
Copy-copies selected object(s) ,Highlighter—use to highlight
— | Paste-pastes copied object(s) 4 Line tool-use to draw lines
2‘ Delete-deletes selected object(s) T Text tool-use to create text
> Media Control-play and pause presentations and ““ Insert Multimedia-inserts
multimedia files images, audio, and video files
g o
@M Pick-picks random participants Window Shade-hides portion
of displayed screen
"'.
J Show Presentation-displays image or > Laser Pointer-displays laser dot
presentation when using the Pen
@' Help Requests-privately displays list of k Pointer-displays arrowhead
participants who requested help when using the Pen
Q" nsert Slide-creates slides for presentation “~ Mouse-operates pen with
mouse functions
vPose—poses question slide Keyboard tool-displays
keyboard
“ Time tool-adds additional time to timer & Function tool-lock/unlock

functions for freehand ability

ﬂﬂ BEEE ﬂm. .m For Numeric question types
ﬂﬂﬂﬁ]@ For Multiple Choice question types

Rate
L2 For Rating question types

m m For Yes/No or True/False question types
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Pen (for Q7RF Instructor Tablet)
Available Fall 2008

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

The Pen is used as a mouse that can left-click, right-click, and double-click to execute
commands and actions on the Q7RF Instructor Tablet.

USB Host (for Instructor Tablet)
Available Fall 2008

*This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

The USB Host is used to collect data from the remotes and record into the Qwizdom
software. This USB Host does not require driver installation.

13.6 Using Remotes in Presentation

Instructor Remote Tips
e The Q5RF instructor remote will display "Ready" or "Last Key.
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e Since the Q5RF remote is not applicable during answer keys, the LCD screen will
display "Access Denied."

e Press the / key on the RF instructor remote to display the response graph.
e Press the / key on the RF instructor remote to close the response graph.

e Press the 0 key on the RF instructor remote to display the graph on the instructor's
LCD.

e Press the Pick (.) key on the RF instructor remote to randomly call upon a participant
during presentation.

e Press the Play (8) key on the RF instructor remote to play/stop movie or sound on
slide.

e Press the Show (7) key on the RF instructor remote to show current scores of
participants/group during game mode.

e Press the New Q (-) key to pose a spontaneous question. A list of question types will
appear on the LCD. Use the up/down arrows on the thumb pad to navigate
through the question types. Press the Send key to select the question type. Select
the correct answer and press Send; or the answer is survey only, press the Send key
without selecting an answer.

e Press the 7 key to display the list of participants who have requested help.

e Press the circle key, in the thumb pad, to close out of the presentation (must be on

last slide), play the PowerPoint® animation and schemes (if any were applied), move
to the next slide, or displays/hides the correct answer on response graph

Participant Remote Tips
e "Qwizdom" will be displayed on the Q4RF and Q5RF remotes when a lesson (non-
question) slide is in view.

e For Q4RF and Q5RF remotes, participants will either see answer choices or a blank
screen (depending on question type) on their remote during a question slide. For

Q2RF remotes, participants will see a blank screen with a battery icon.

e Torequest help on the Q4RF and Q5RF remotes, press the Menu key to select Help
and press Send. For Q2RF remotes, press the Help (Hand) key.

e To change the Session ID on the Q4RF remote, press the Menu key and use the right
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arrow to scroll through the menu options. When you see Sess. ID, press the Send key
to select it. An existing Session ID may appear and the remote will ask if you want to
change it. Press T for yes and enter the new Session ID. Press the Send key to
confirm.

e To change the Session ID on the Q5RF remote, press the Menu key when the
remote displays "No Host Found." Use the thumb pad to navigate through the menu
options and press the Send key to select Enter Session ID.

e To change the Session ID on the Q2RF remote, wait for the remote to time out. You
will see "- - -" appear on the screen and the remote will automatically turn off. When
you turn it back on, press the Help key. When you see "--S" on the display, enter the
Session ID and press the Send key to confirm.

e To change the user ID on the Q4RF remote, press the Menu key and use the right
arrow key to scroll to User ID. An existing user ID may appear and the remote will
ask if you want to change it. Press T for yes and enter a user ID. Press the Send key to
confirm.

e The LCD screen on the participant remotes may read "Push Key," "Inactive," or "Not
Active," press the Send (double arrows) key to 'wake up' the remote. If the remote
still displays "Not Active," re-enter the Session ID.

o If the Q4RF displays "No Net; or the Q5RF remote displays "Host not found;" or the
Q2RF remote displays "- - -" and turns off, re-enter the Session ID. Go to
ChanginglSessionlDs for more information.

e If the Q4RF remote displays "Denied;" or the Q5RF remote displays "Access Denied;"
or the Q2RF remote displays "--U," the Participant ID is incorrect, or the Remote ID
attempting to participate isn't in the participant list that was loaded. Re-enter the
Participant ID, and check to make sure that Remote ID is in the participant list.

Below are the procedures on how to respond for each question type during presentation:
e True/False; select T or F and press the Send key.

e Yes/No; select Y or N and press the Send key.

e Multiple Choice; select A, B, C, D, E, or F and press the Send key.
e Multiple Mark; select the letter choices and press the Send key.
e Numeric; enter the numbers and press the Send key.

e Sequence; enter the numbers in the order and press the Send key.
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Multiple Answer-List; press the letter choices and press the Send key.

Fill-in/Completion; for Q5 remotes only-for one answer you will see:

1)

*)Send
Make sure 1) is highlighted and press either the Circle or the Send key to select it.
1) will appear on the LCD. Press the Menu key to display the

alphabet. Use the arrows on the thumb pad to navigate through the letters, using
the Circle key to select the letter(s). Press the Send key when finished entering the
answer. You will see 1)your answer. Press the down arrow on the thumb pad to
select *)Send and press the Send key to confirm the answer.

For two answers, you will see:

1)

2)

*)Send
Make sure 1) is highlighted and press either the Circle or the Send key to select the
question number. 1) will appear on the LCD. Press the Menu key to

display the alphabet. Use the arrows on the thumb pad to navigate through the
letters, using the Circle key to select the letter(s). Press the Send key when finished
entering the answer. You will see 1)your answer.

Press the down arrow on the thumb pad to select 2) and press the Circle
or Send key to select the question number. 2) will appear on the LCD.
Press the Menu key to display the alphabet. Use the arrows on the thumb pad to
navigate through the letters, using the Circle key to select the letter(s). Press the
Send key when finished entering the answer. You will see 2)your answer.

Press the down arrow on the thumb pad to select *)Send and press the Send key to
confirm the answers.

Short Answer-Specific; for Q5 remotes only. The alphabet menu will automatically
appear when this question type is displayed. Use the arrows on the thumb pad to
navigate through the letters, using the Circle key to select the letter(s). Press the
Send key to confirm your answer.

14  Troubleshoot

14.1 Uninstalling Software and Hardware

Uninstalling Qwizdom Connect

1.

2.
3.
4

Go to Add/Remove programs in the Control Panel.

Search for Qwizdom Connect and click Remove.

The InstallShield wizard will appear and follow the instructions.
Restart your computer for the changes to take affect.

Qwizdom Connect 2008
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Uninstalling USB Drivers (RF Host)
If the host is still not initializing after following the steps above, then the hardware needs
to be completely removed and then reinstalled. Follow the steps below.

1.
2.

No wuk

Go to your Control Panel from either your Settings or Start menu.

Double-click on System and click on the Hardware tab or Device Manager tab. If
you go to the Hardware tab, click on the Device Manager button.

Search for the Qwizdom RF Host under Universal Serial Bus Controllers, Ports, and/or
Other or Unknown Devices.

Double-click on the file and click on the Driver tab.

Select Uninstall.

Unplug your host after it is uninstalled and go back to the Control Panel.
Double-click on Add or Remove Programs and search for FTDI Universal Serial
Converter Drivers.

When you find it, remove the file.

Qwizdom Connect 2008
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